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1 OM KOMPENDIET 

Gode kart og løyper er en viktig forutsetning for et godt o-arrangement. En pre-o konkurranse stiller 

større krav til et presist o-kart enn hva som er tilfellet i de andre o-grenene, og kravene til 

løypelegging er annerledes i pre-o enn i tradisjonelle fot-o konkurranser. Pre-o-arrangører har derfor 

ofte behov for å gjøre korrigeringer på eksisterende kart før de kan benyttes i en pre-o-konkurranse.  

Kompendiet har fokus på de grunnleggende prinsippene for hvordan OCAD kan benyttes som et 

nyttig verktøy i forbindelse med pre-o-arrangement. Kompendiet omhandler ikke de generelle 

kravene som er satt til et pre-o-arrangement, men retningslinjene ligger til grunn for de stegvise 

beskrivelsene i dette kompendiet. Spesielt er verken den nødvendige revideringen av pre-o-kartet før 

en konkurranse som sikrer at kartet er presist nok til å kunne brukes til en pre-o-konkurranse eller 

løypelegging for ulike nivå tema i dette kompendiet. 

Motivasjonen og tanken bak kompendiet er å lage en guide som beskriver de spesifikke 

kartoppgavene som en pre-o-arrangør blir stilt ovenfor. Vi kjenner ikke til at det finnes noen slik 

dokumentasjon per dags dato. Kompendiet er delt inn i to fokusområder, hvor størst vekt er lagt på 

punkt 2, da det allerede finnes en del dokumentasjon på punkt 1. 

1. Å kunne bruke OCAD generelt til både karttegning og løypetegning. 

2. Å dokumentere hvordan man på en enkel måte kan lage tidspostkart, løsningskart og utføre 

andre pre-o-spesifikke oppgaver som det finnes lite dokumentasjon om generelt i o-

verdenen. 

Guiden tar utgangspunkt i den engelske versjonen av OCAD, men en norsk versjon av programmet er 

tilgjengelig.  

Vi håper guiden kan være et nyttig oppslagsverk både for de som kan OCAD fra før, men som ikke har 

brukt programmet så mye i pre-o sammenheng, og for de som er nybegynner i OCAD. Enkelte 

kapitler er markert med *, noe som forteller at dette kapittelet ikke er veldig viktig for nybegynnere, 

og kan hoppes over av de som anser seg som nybegynnere. 

Kompendiet henviser til en del OCAD-maler som vil forenkle arbeidet med pre-o løypelegging, 

produksjon av løsningskart og tidspost-/temp-o-kart. Disse malene kan lastes ned fra: 

http://dl.dropbox.com/u/14588107/Diverse/OCAD_kurs/Pre-o-maler_OCAD11.zip  

Vi håper kompendiet vil være et nyttig hjelpemiddel i forbindelse med kartproduksjon og 

løypelegging i forbindelse med pre-o arrangement. 

Lykke til med kart- og løypearbeidet. 

  

Geir Myhr Øien og Martin Jullum 

Hamar / Oslo, mars 2013 

  

http://dl.dropbox.com/u/14588107/Diverse/OCAD_kurs/Pre-o-maler_OCAD11.zip
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3 LITT OM OCAD 

OCAD er det ledende programmet for tegning av orienteringskart og løypelegging innenfor 

orienteringsverdenen. Så å si all o-kart er i dag tegnet i OCAD. Per 2013 er den nyeste versjonen av 

OCAD versjon 11. Det finnes imidlertid ulike utgaver av OCAD 11:  

Orienteering Standard: Dette er som navnet tilsier hovedversjonen tilpasset orientering. Denne 

utgaven har alt man behøver til ikke-profesjonell karttegning. (Anbefales) 

Starter: Dette er en «strippet» versjon av Orientering Standard med begrensninger på blant annet 

antall kartobjekter. Denne utgaven mangler også noen verktøy som er nyttig for pre-o-bruk.  

Course Setting: Dette er en versjon som kun kan brukes til løypelegging og ikke karttegning. 

Løypeleggingsfunksjonen finnes for øvrig i alle de andre versjonene, så man trenger ikke denne i 

tillegg. 

Professional: Dette er versjonen for avansert karttegning for de som driver med kart av yrke. 

Mer om OCAD kan leses på programmets hjemmeside: http://www.ocad.com/ Spesielt nyttig er 

OCAD 11 Wiki som du finner på http://www.ocad.com/en.wiki/. Det finnes også en rekke 

instruksjonsvideoer som guider deg gjennom verktøyene i OCAD: http://ocad.com/en/support/learn-

video.  

Engelsk bruksanvisning til OCAD 11 finnes her: 

http://www.ocad.ch/downloads/ocad11/gs/Getting_Started_OCAD_11_English.pdf 

Den norske bruksanvisningen fra OCAD 10 (med små forskjeller til versjon 11) finnes her: 

http://www.ocad.ch/OCAD10/OCAD10_GettingStarted_Norwegian.pdf 

Andre nyttige lenker er en blogg om karttegning i OCAD http://ocad-kart.blogspot.no/ og en dansk 

hjemmeside om tegning av sprintkart: http://www.soenniksen.dk/sprintkort.  

Et kurshefte for OCAD fra Konkylie data også bestilles fra følgende lenke (200 NOK): 

http://www.konkylie.no/index.php?txt=OCAD_kurshefter, eller lastes ned (kun for skjermlesing) 

herfra: http://www.kartarkiv.no/kurs/OCAD-kurs_2014.pdf.  

Til slutt et par tips rundt lagring og angring i OCAD: 

Det er fort gjort å gjøre feil når man jobber med denne typen program, spesielt om man ikke er så 

vant til programmet. Knappene for «angre» (til venstre) og «gjør om» (til høyre)  på 

verktøylinja er derfor veldig meget nyttige. Angreknappen brukes når man har tegnet, redigert eller 

lagt inn noe feil på kartet og ønsker å gå tilbake slik kartet var før denne endringen. «Gjør om» 

reverserer prosessen igjen.  Det er imidlertid verdt å merke seg at angreknappen ikke kan brukes på 

alle typer operasjoner. Endring av målestokk, symbolstørrelse, endringer på et bakgrunnsbilde og 

andre typer operasjoner som berører hele kartet kan ikke angres. Når man skal utføre slike 

operasjoner er det derfor viktig å lagre på forhånd. Generelt er det også god rutine å lagre ofte med 

ulike navn for hver oppdatering. F.eks. kan man navngi filene som «mitt_kart_versjon_x» der man 

øker «x» med en hver gang man skal lagre. Når man lagrer på denne måten er det ikke så farlig om 

man gjør en feil man først finner ut av en stund senere siden man da enkelt kan gå tilbake til en 

tidligere versjon. I tillegg kan det være lurt å ta backup av mappa med alle kartfilene man jobber med 

på en ekstern harddisk i tilfelle datakrasj eller lignende. 

  

http://www.ocad.com/
http://www.ocad.com/en.wiki/
http://ocad.com/en/support/learn-video
http://ocad.com/en/support/learn-video
http://www.ocad.ch/downloads/ocad11/gs/Getting_Started_OCAD_11_English.pdf
http://www.ocad.ch/OCAD10/OCAD10_GettingStarted_Norwegian.pdf
http://ocad-kart.blogspot.no/
http://www.soenniksen.dk/sprintkort
http://www.konkylie.no/index.php?txt=OCAD_kurshefter
http://www.kartarkiv.no/kurs/OCAD-kurs_2014.pdf
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4 REDIGERING AV KART 

OCAD er et program for alle typer av kart, men er mest utbredt i forbindelse med tegning av 

orienteringskart. Programmet har et vidt spekter av kartredigeringsfunksjoner, alt fra enkel tegning 

av punkter, linjer og flateobjekter til mer avanserte funksjoner for behandling av digitale 

terrengmodeller (laserdata) og databaser. Brukeren kan velge om kartet skal være såkalt georeferert 

eller ha sitt eget lokale koordinatsystem.  

Programmet tillater import og eksport av mange forskjellige filformater, både vektor- og rasterkart. I 

tillegg tilbyr programmet muligheten for å lage internettkart. Bruk av scannede papirkart (for 

eksempel synfaringsnotater), kan enkelt benyttes som bakgrunnskart for videre digitalisering. 

Dette kapittelet vil se på noen av de mest vanlige funksjonene som benyttes i forbindelse med 

tegning og redigering av kart. Hvordan de ulike funksjonene brukes vil ikke bli beskrevet i detalj, kun 

hva de ulike funksjonene innebærer. En mer utførlig beskrivelse av funksjonene i OCAD er å finne på 

OCADs Wikisider: http://ocad.com/en.wiki (engelsk) 

OCAD tilbyr også en rekke instruksjonsvideoer og eksempeldata på sine hjemmesider: 

http://ocad.com/en/support/learn-video  

Hovedfunksjonene den guiden ser nærmere på er som følger: 

1. Symboler 

2. Tegneverktøy 

3. Redigeringsverktøy 

4. Bakgrunnskart 

5. Import av digitalt kartgrunnlag 

 

HUSK: Det er veldig viktig at man lagrer ofte. Med jevne mellomrom bør man også lagre filen med 

nytt navn, File > Save As… (f.eks. «dette_er_min_fil_versjon_xxxx.ocd») slik at man kan gå tilbake 

dersom man gjør feil.  

http://ocad.com/en.wiki
http://ocad.com/en/support/learn-video
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4.1 SYMBOLER 
Symboler er brukt til å beskrive landskap og terreng i form av kartet. Et kart avbilder et stykke av 

landskapet i en forenklet form. For orienteringskart er det to standarder som kan benyttes når o-kart 

skal utarbeides.  

 ISOM 2000, som benyttes for tradisjonelle o-kart 

http://orienteering.org/wp-content/uploads/2010/12/International-Specification-for-

Orienteering-Maps-2000_2.pdf 

 ISSOM 2007, som benyttes ved utarbeidelse av sprint kart 

http://orienteering.org/wp-content/uploads/2010/12/International-Specification-for-Sprint-

Orienteering-Maps-2007_corrected-201211.pdf  

Dette er internasjonale standarder for o-kart som beskriver hvilke symboler som skal benyttes for å 

beskrive terrenget, i tillegg til farge og størrelse på symbolene. Hvilken standard som benyttes 

avhenger av kartets utstrekning, område og bruk. I pre-o sammenheng kan begge standardene 

benyttes, men ved bruk av ISOM 2000 tilsier retningslinjer for pre-o at tilpasningen i kapittel 5, Fra 

fot-o-kart til pre-o-kart, må gjøres.  

I OCAD finnes det ferdige symbolmaler for de ulike standardene, og 

ønsket standard velges når ei ny kartfil lages (Fil > New…). I pre-o-

sammenheng tar man gjerne utgangspunkt i et eksisterende o-kart, 

som man ønsker å revidere slik at de tilfredsstiller «kravene» for pre-o-

kart. I den sammenheng kan det være behov for å lage ny, slette eller 

endre på eksisterende symboler. Oversikten over hvilke symboler som 

er tilgjengelig i ei OCAD-fil ser man i høyremargen av programmet når 

fila er åpnet, se også Figur 1. 

OCAD har fire forskjellige typer symboler, men de ulike symbolene kan 

gis forskjellige egenskaper (f.eks. alltid rotert mot nord): 

 Punktsymbol 

 Linjesymbol 

 Flatesymbol 

 Tekstsymbol 

Alle symbolene blir i symboloversiktene, Figur 1, visualisert med et ikon. 

Merk at dette ikonet ikke nødvendigvis illustrerer eksakt hvordan 

symbolet vil ta seg ut i kartet.  

Når man ønsker å gjøre endringer i symbolregisteret gjør man dette 

enklest ved å høyreklikke med musa på et av symbolene i listen og velge 

et av valgene som kommer opp. Alternativt kan må velge "Symbol" fra 

menylinja. 

Under følger en beskrivelse av noen av de mest brukte justeringsmulighetene. En komplett liste over 

alle funksjonene finner du her: http://www.ocad.com/en.wiki/index.php?title=Symbol (engelsk). 

4.1.1 Nytt symbol (New…) 

Benyttes til å etablere et helt nytt symbol, og man får da muligheten til å velge en av de seks 

symboltypene: punkt, linje, flate, tekst, tekst langs ei linje, rektangel flate (gjerne brukt på symboler 

slik som bygninger, rammer o.l.). 

Figur 1: Eksempel på 
symboloversikten i OCAD 

http://orienteering.org/wp-content/uploads/2010/12/International-Specification-for-Orienteering-Maps-2000_2.pdf
http://orienteering.org/wp-content/uploads/2010/12/International-Specification-for-Orienteering-Maps-2000_2.pdf
http://orienteering.org/wp-content/uploads/2010/12/International-Specification-for-Sprint-Orienteering-Maps-2007_corrected-201211.pdf
http://orienteering.org/wp-content/uploads/2010/12/International-Specification-for-Sprint-Orienteering-Maps-2007_corrected-201211.pdf
http://www.ocad.com/en.wiki/index.php?title=Symbol
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Mer info om etablering av nye symboler: 

http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Symbol 

4.1.2 Endre på et symbol (Edit…) 

Ofte er det aktuelt å endre på et eksisterende symbol. F.eks. kan det være aktuelt å endre farge eller 

teksttype, noe som kan gjøres ved å høyreklikke med musa på det symbolet som skal endres å så 

velge "Edit..". Man har da en rekke muligheter for å endre symbolet avhengig av hva slags 

symboltype det er. 

I tabellen under kan man finne mer informasjon om hvordan man lager nye eller editerer på allerede 

eksisterende objekt av forskjellige typer. 

Symbol type: Trinnvis beskrivelse (engelsk) Video 

Punkt http://www.ocad.com/en.wiki/index.php?t
itle=Create_a_New_Point_Symbol  

http://ocad.com/howtos/64.htm  

Linje http://www.ocad.com/en.wiki/index.php?t
itle=Create_a_New_Line_Symbol  

http://ocad.com/howtos/44.htm  

Flate http://www.ocad.com/en.wiki/index.php?t
itle=Create_a_New_Text_Symbol  

http://ocad.com/howtos/61.htm  

Tekst http://www.ocad.com/en.wiki/index.php?t
itle=Create_a_New_Text_Symbol  

http://ocad.com/howtos/62.htm  

Tekst langs 
linje 

http://www.ocad.com/en.wiki/index.php?t
itle=Create_a_New_Line_Text_Symbol  

 

Flate, 
rektangel 

http://www.ocad.com/en.wiki/index.php?t
itle=Create_a_New_Rectangle_Symbol  

 

 

4.1.3 Endre symbolstørrelse (Enlarge/Reduce…) 

Dette er en funksjon som er meget aktuell å benytte når man skal etablere et pre-o-kart fra at fot-o-

kart, for at symbolstørrelsen skal bli riktig i henhold til gjeldende retningslinjer for pre-o-kart. 

Symbolstørrelsen på alle objektene kan endres samtidig. Hvordan dette gjøres er nærmere beskrevet 

i kapittel 5.3, Skalere symboler.  

Å endre symbolstørrelse på et enkelt symbol kan enkelt gjøres ved å høyreklikke på det aktuelle 

symbolet, og velge "Enlarge/Reduce…" og deretter fylle ut hvor mange prosent man ønsker å justere 

symbolstørrelsen med. Hvis man velger 200 % vil symbolstørrelsen fordobles, mens den vil halveres 

ved 50 %. Haker man av for "All symbols" i Figur 15, så vil alle symbolene i fila endres med det angitte 

antall prosent. 

4.1.4 Kopi (Copy) 

Hvis man ønsker å lage et nytt symbol som ligner mye på et allerede eksisterende symbol, så er det 

enkleste å lage en kopi av det eksisterende symbolet. Dette gjøres ved å høyreklikke på symbolet og 

velge "Copy", for deretter å høyreklikke på det stedet i symboloversikten hvor man ønsker å sette inn 

kopien å velge "Paste". 

Videre endrer man på det nye symbolet (kopien), ved å høyreklikke på symbolet og velg "Edit" slik 

som beskrevet over. For å skille kopien fra originalen kan det være smart å endre på ikonet til 

symbolet. Dette kan gjøres som beskrevet her: 

http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Symbol#Icon_Editor  

En alternativ metode for å lage en kopi av et eksisterende symbol er å høyreklikke på symbolet og 

velge "Duplicate". En kopi av symbolet vil da automatisk dukke opp ved siden av det valgte symbolet.  

http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Symbol
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Point_Symbol
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Point_Symbol
http://ocad.com/howtos/64.htm
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Line_Symbol
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Line_Symbol
http://ocad.com/howtos/44.htm
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Text_Symbol
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Text_Symbol
http://ocad.com/howtos/61.htm
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Text_Symbol
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Text_Symbol
http://ocad.com/howtos/62.htm
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Line_Text_Symbol
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Line_Text_Symbol
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Rectangle_Symbol
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Rectangle_Symbol
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Symbol#Icon_Editor
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4.1.5 Flytte et symbol i symbollista* 

Noen ganger ønsker man å endre et symbols plassering i symboloversikten, f.eks. for å samle 

spesielle typer symboler. Dette kan gjøres ved å klikke på venstre museknapp på symbolet, og dra 

symbolet til ønsket posisjon samtidig som man holder venstre museknapp nedtrykt. Slipp museknapp 

for å plassere symbolet. 

4.1.6 Velg symboler* 

Symboloversikten inneholder alle symboler som ble definert ved etablering av et nytt kart, samt de 

egendefinerte. Oversikten kan derfor inneholde mange flere symboler enn det som er benyttet i 

kartet. Ved å høyreklikke på et symbol kan man velge "Select" og få opp muligheten til å velge 

"Used", "Unused", "Invert" eller "All".  

Ønsker man f.eks. å slette alle symboler som ikke er brukt i kartet, kan man velge "Unused" og 

deretter høyreklikke på et de valgte objektene og velge "Delete". 

Mer om "Select"-funksjonen her: http://www.ocad.com/en.wiki/index.php?title=Symbol_Box#Select  

4.1.7 Symbolenes status 

I utgangspunktet er alle symbolene som er definert i symboloversikten synligere og redigerbare i 

kartet. Av og til ønsker man å skjule noen symboler fra kartutskriften eller å låse allerede tegnede 

objekter fra videre redigering. 

Ved å høyreklikke på et symbol får man opp følgende tre status valg: 

 Normal: Dette er standard innstillingen for alle symbolene, hvor de både vises i kartet og er 

redigerbare. 

 Protect: Velger man denne statusen for et symbol vil symbolet fortsatt være synlig i kartet, 

men man vil ikke ha muligheten til å endre på allerede eksisterende objekter i kartet, eller å 

tegne ny objekter. Denne funksjonen kan være aktuell å benytte når mange kartobjekter 

ligger nærmere hverandre, eller oppe på hverandre, og man skal redigere på kun et eller 

noen få objekt. Symboler med denne statusen vil få en grå strek over ikonet. 

 Hide: Velger man denne statusen vil ikke symbolet vises i kartbildet. Objekter med denne 

statusen blir ikke med på utskrift eller eksport. 

Symboler med denne statusen vil få et grått kryss over ikonet. 

Mer om de ulike statusene: http://www.ocad.com/en.wiki/index.php?title=Symbol#Symbol_Status  

4.2 TEGNEVERKTØY 
 

OCAD har mange funksjoner for karttegning i sin verktøykasse. En samlet oversikt over alle 

tegneverktøyene og hvordan disse benyttes er å finne på OCAD sin wiki side: 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object. Alternativt kan man bruke den 

norske bruksanvisningen til OCAD 10 som beskriver de grunnleggende funksjonene i OCAD. Den 

finnes her: http://www.ocad.ch/OCAD10/OCAD10_GettingStarted_Norwegian.pdf 

De ulike tegneverktøyene finner man som forskjellige 

knapper på verktøylinja. Figur 2 viser de tegneverktøyene 

som det er mest vanlig å benytte. Her følger en kort 
Figur 2: Tegneverktøy OCAD 

http://www.ocad.com/en.wiki/index.php?title=Symbol_Box#Select
http://www.ocad.com/en.wiki/index.php?title=Symbol#Symbol_Status
http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object
http://www.ocad.ch/OCAD10/OCAD10_GettingStarted_Norwegian.pdf
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beskrivelse av de ulike knappene, for mer detaljerte beskrivelser se lenkene over.  

Den generelle metoden for å starte å tegne et nytt objekt er som følger: 

1. Velg ønsket symbol i symbollista til høyre i vinduet. 

2. Velg så det tegnesymbolet du ønsker å bruke for å tegne objektet på kartet (se Figur 2) 

3. Start å tegne med musa etter beskrivelsene beskrevet eller referert til nedenfor. 

4.2.1 T1: Kurve 

 

Bézier-kurven er et mye brukt tegneverktøy for kurver i ulik CAD-programvare, slik som OCAD. Det 

kreves gjerne litt trening for på en effektiv måte greie å tegne med Bézier-kurve-verktøyet, men 

dette gir helt klart de fineste kurvene. Dette tegneverktøyet anbefales blant annet til tegning av 

høydekurver, stier og flater. Det som er spesielt med denne kurvetypen er at man justerer linjens 

kurvatur ved å justere på tangenten som dannes med utgangspunkt i kurvepunktene. 

En nærmere beskrivelse av hvordan bézier-kurve-funksjonen benyttes se: 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Dr

aw_a_Curve  

eller se følgende instruksjonsvideo: http://ocad.com/howtos/25.htm 

 

4.2.2 T2: Ellipse 

 

Ellipse er et enkelt verktøy å bruke for å tegne nettopp ellipser. Et 

vanlig bruksområde for denne funksjonen er tegning av avlange koller. 

Verktøyet kan også brukes til å tegne flater som skal ha utforming som en ellipse. Ellipsefunksjonen 

benyttes på følgende måte: 

 Velg et linje- eller flatesymbol i symbollista til høyre i hovedvinduet. 

 Velg ellipse verktøyet. 

 Klikk på det ene ytterpunktet av ellipsen for deretter å klikke på det diagonalt andre 

ytterpunktet, samtidig som man holder venstre musetast ned for å dra ut ellipsens bredde 

ved å flytte musepekeren sideveis i forhold til den digitaliserte linjen. (Her er det lurt å prøve 

seg litt fram) 

 Slipp den venstre musetasten når du har fått ønsket bredde på ellipsen. 

Figur 3: Bézier kurve 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Curve
http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Curve
http://ocad.com/howtos/25.htm
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Figur 4: Tegn sirkel med gitt radius 

En nærmere beskrivelse av hvordan ellipsefunksjonen fungerer finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_an_Elliptical_Object 

eller i følgende instruksjonsvideo:  

http://www.ocad.com/howtos/21.htm  

4.2.3 T3: Sirkel 

 

Verktøy for å tegne sirkler. Det er to metoder å benytte dette verktøyet på. 

Metode 1:  

 Velg et linje- eller flatesymbol. 

 Velg sirkelverktøyet. 

 Klikk på et av ytterpunktene i sirkelen som skal tegnes, og hold nede venstre musetast, og 

dra ut sirkelen ved å flytte musepekeren.  

Metode 2:  

 Velg et linje- eller flatesymbol. 

 Velg sirkelverktøyet. 

 Klikk i sentrum av sirkelen som skal tegnes, og 

dialogboksen i Figur 4 kommer opp. Fyll ut radiusen på sirkelen, før man klikker OK. 

En nærmere beskrivelse av hvordan sirkelfunksjonen 

fungerer finner her: 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Circular_Object 

eller i følgende instruksjonsvideo:  

http://www.ocad.com/howtos/22.htm 

4.2.4 T4: Linje – rette linjer 

  

Velg dette verktøyet for å tegne rette linjer med 90 grader i alle hjørner. Denne funksjonen kan typisk 

brukes til å tegne parkeringsplasser eller trapper. Det som skiller dette tegneverket fra T5: Rektangel, 

er at start og sluttpunkter ikke trenger å være samme sted. Dette verktøyet funger på både linje- og 

flatesymboler. 

En nærmere beskrivelse av hvordan dette tegneverktøyet fungerer finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Rectangular_Line 

eller se følgende instruksjonsvideo:  

http://ocad.com/howtos/23.htm  

4.2.5 T5: Rektangel 

  

Dette verktøyet brukes til å tegne rektangulære flater, typisk bygninger. I motsetning til verktøy T4: 

Linje -  rette linjer, så benytter dette samme start- og sluttpunkt i den tegnede figuren, noe som gjør 

at man får en lukket figur/flate.  

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_an_Elliptical_Object
http://www.ocad.com/howtos/21.htm
http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Circular_Object
http://www.ocad.com/howtos/22.htm
http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Rectangular_Line
http://ocad.com/howtos/23.htm
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Figur 5: Eksempel på innmåling av terrengdetaljer 

Verktøyet brukes på den måten at man først tegner en rett linje mellom to punkter, f.eks. en husvegg 

og drar videre linjer 90 grader til høyere eller venstre for den sist tegnede linjen. Dette gjøres ved å 

holde venstre musepeker nede etter at man har digitalisert et punkt. Et nytt punkt settes inn i 

rektangelet der hvor musepekteren slippes, og man tegner videre ved å holde venstre muespeker 

nede. Figuren lukkes / avsluttes ved å dobbelklikke på siste punkt.   

En nærmere beskrivelse av hvordan dette tegneverktøyet fungerer finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Rectangular_Area 

eller se følgende instruksjonsvideo:  

http://ocad.com/howtos/23.htm  

4.2.6 T6: Rett linje 

 

Brukes for å tegne rette linjer mellom hvert punkt man klikker i kartet. Dette fungerer på alle linje- og 

flatesymboler, og er enkel måte å tegne rette linjer på, slik som f.eks. kraftlinjer. 

En nærmere beskrivelse av hvordan dette tegneverktøyet fungerer finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Straight_Line 

eller se følgende instruksjonsvideo:  

http://www.ocad.com/howtos/20.htm 

4.2.7 T7: Frihåndstegning 

 

Frihåndstegning fungerer på den måten at man velger et linje- eller flatesymbol og klikker i kartet 

hvor man ønsker å begynne å tegne objektet. Etter hvert som man flytter musepekeren rundt i kartet 

vil programmet automatisk sette inn punkter ut fra musepekerens bevegelser. For å avslutte 

frihåndstegninger klikker på nytt i kartet. Dette er ingen enkel eller god måte å tegne fine linjer / 

kurver på, så det er heller å anbefale å benytte T1: Kurve eller en av de andre tegnefunksjonene.  

En nærmere beskrivelse av hvordan dette tegneverktøyet fungerer finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Freehand_Line 

4.2.8 T8: Numerisk tegnefunksjon* 

 

Den funksjonen benyttes om linjer 

eller flater skal tegnes med 

utgangspunkt i kjente koordinater 

eller retninger og avstander. Dette 

gir linjer med helt eksakt avstand og 

vinkel. Hvis man i 

synfaringssammenheng har målt 

retningsvinkel og avstand fra et 

punkt til et annet, se Figur 5, kan 

denne funksjonen være nyttig å 

benytte. Har man foretatt to eller 

flere slike målinger for å bestemme 

samme punkt ved synfaring, så kan 

denne metoden benyttes for å 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Rectangular_Area
http://ocad.com/howtos/23.htm
http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Straight_Line
http://www.ocad.com/howtos/20.htm
http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Freehand_Line
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beregne krysningspunktet mellom disse målingene ved å digitalisere en hjelpelinje per måling. 

Funksjonen kan også benyttes på punktobjekter hvis man ønsker å tegne flere enkeltpunkter etter 

hverandre hvor man kjenner den relative posisjonen mellom punktene. Merk at man i denne 

funksjonen kan velge mellom å beregne de relative posisjonene i papir millimeter eller meter i 

terreng. 

En nærmere beskrivelse av hvordan dette tegneverktøyet fungerer finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Numerical_Drawing_Mode 

eller se følgende instruksjonsvideo:  

http://www.ocad.com/howtos/27.htm 

4.2.9 Tegning av punktobjekter 

Ved tegning av et punktobjekt kan alle de 8 ovenfor nevnte tegneverktøyene benyttes. 

 Velg et punktsymbol 

 Velg et av de 8 tegneverktøyene 

 Klikk i kartet hvor symbolet skal tegnes. 

 For enkelte punktsymboler kan det noen ganger være aktuelt å tegne med en annen retning 

enn nord-sør, f.eks. fallstreker. Dette gjøres ved å holde venstre musetast nede, etter at man 

har trykket i kart, og dra musepekeren i den retningen "opp" på symbolet skal være. 

En nærmere beskrivelse av hvordan dette tegneverktøyet fungerer finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Point_Object 

eller se følgende instruksjonsvideo: http://www.ocad.com/howtos/26.htm 

4.3 REDIGERINGSVERKTØY 
OCAD tilbyr en lang rekke med redigeringsverktøy som er nyttige å benytte når man jobber med 

karttegning eller redigering. Det er enkelt å velge eksisterende kartobjekter for å justere på objektets 

posisjon eller utstrekning, eller bytte et allerede eksisterende kartobjekt med et annet symbol. F.eks. 

kan en stein enkelt endres til et blokkfelt, uten at man trenger å slette eksisterende objekt, før man 

tegner et nytt. 

Alle linje- og flateobjekter i OCAD er tegnet med en definert retning. For de fleste symbolene har ikke 

linjens retning noen betydning, presentasjonen blir lik uansett. Noen symboler blir derimot tegnet 

med utgangspunkt i linjens tegneretning. Eksempler på slike symboler som er gjerder og stup. 

Hvilken side "taggene" på disse to objektene skal tegnes på, avhenger av linjens retning. 

Dette kapittelet gir en overordnet beskrivelse av noen av de mest brukte redigeringsverktøyene i 

OCAD11. En komplett oversikt over alle redigeringsverktøyene og hvordan disse benyttes er å finne 

på OCAD sin wikisider: http://www.ocad.com/en.wiki/index.php?title=Select og 

http://www.ocad.com/en.wiki/index.php?title=Edit_Object. Alternativt kan man bruke den norske 

bruksanvisningen til OCAD 10 som beskriver de grunnleggende funksjonene i OCAD. Den finnes her: 

http://www.ocad.ch/OCAD10/OCAD10_GettingStarted_Norwegian.pdf 

De ulike redigeringsverktøyene finner man som 

forskjellige knapper på verktøylinja. Figur 6 viser 

de redigeringsverktøyene som det er mest vanlig 

å benytte. Her følger en kort beskrivelse av de 

ulike knappene. For mer detaljerte beskrivelser se 

lenkene over.  

Figur 6: Noen utvalgte redigeringsverktøy i OCAD11 

http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Numerical_Drawing_Mode
http://www.ocad.com/howtos/27.htm
http://www.ocad.com/en.wiki/index.php?title=Drawing_an_Object#Draw_a_Point_Object
http://www.ocad.com/howtos/26.htm
http://www.ocad.com/en.wiki/index.php?title=Select
http://www.ocad.com/en.wiki/index.php?title=Edit_Object
http://www.ocad.ch/OCAD10/OCAD10_GettingStarted_Norwegian.pdf
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4.3.1 R1: Valg og endring av objekt 

 

For å redigere et objekt velges denne knappen på verktøylinja. Etter at 

 er valgt klikker man på det objektet i kartet som skal redigeres. 

Objektet vil da bli markert som i Figur 7.  

De 8 svarte firkantene definerer objektets ramme og benyttes til å 

justere objektet størrelse. Størrelsen justeres ved å peke på et av 

punktene for så å dra punktet innover eller utover, avhengig av om man 

ønsker å krympe eller forstørre objektet. 

Ved å peke på en av de åpne firkantene får man muligheten til å flytte på 

hele objektet. Dette gjøres ved å klikke på en av disse hvite firkantene, 

holde venstre musetast nede og dra objektet til ønsket posisjon, for så å 

slippe musetasten. 

Denne funksjonen kan benyttes i kombinasjon med andre redigeringsfunksjoner som beskrevet 

under. I tillegg til de allerede nevnte funksjonene, kan  knappen brukes i kombinasjon med, 

sletting av objekt (gjøres ved å trykke "Delete" på tastaturet når objektet er valgt), kopiering av 

objekt, fylle eller lage kantlinjer på en eksisterende flate og mange flere. En beskrivelse av disse 

mulighetene er å finne på OCADs Wiki side: http://www.ocad.com/en.wiki/index.php?title=Select og 

http://www.ocad.com/en.wiki/index.php?title=Edit_Object, eller i den norske OCAD 10 

bruksanvisningen som nevnt over. 

4.3.2 R2: Velg objekt og endre punkt 

 

Denne verktøyknappen kan kombineres med mange av de andre redigeringsverktøyene nevnt i 

avsnittet over. Hovedforskjellen på  og  er at man ved bruk av 

 kan justere de enkelte punktene som utgjør linja eller flata. Ved å 

klikke på en av de åpne firkantene i Figur 8, og holde venstre musetast 

nede kan det aktuelle punktet dras til ønsket posisjon. På denne 

måten kan objektets utstrekning og form justeres.  

Ved bruk av denne funksjonen på objekter som er tegnet med Bézier-

kurven (T1: Kurve) i Figur 3, vil man ha muligheten til å justere på 

kurvens radius ved å dra i tangentpunktene. Dette er en svært nyttig 

og mye brukt funksjon.  

Ofte har man behov for å finjustere på de tegnede kartfigurene etter 

at man har brukt tegneverktøyet. Når man jobber med et av de 8 tidligere nevnte tegneverktøyene 

kan man raskt bytte til  eller  ved å klikke på høyre musetast og velge en av de to 

redigeringsverktøyene (alternativt kan de velges fra verktøylinja).  

Mer informasjon om dette redigeringsverktøyet er å finne på samme lenker som for  R1: Valg og 

endring av objekt. 

4.3.3 R3: Roter objekt 

 

Figur 7: Valgt objekt, med 
redigeringspunkter 

Figur 8: Velg objekt og redigere punkt 

http://www.ocad.com/en.wiki/index.php?title=Select
http://www.ocad.com/en.wiki/index.php?title=Edit_Object
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Noen ganger kan man ha behov for å rotere et objekt. Det kan enkelt gjøres ved å benytte 

roteringsfunksjonen. Når dette verktøyet skal benyttes, bør man først velge det objektet som ønskes 

rotert med enten  eller , før rotasjonsknappen  på verktøylinja velges. Når  er valgt, 

klikker man først på det punktet på kartet hvor objektet skal roteres rundt, for deretter å klikke på 

nytt i kartet, samtidig som man holder venstre musetast nedtrykt, og dreier objektet til ønsket 

posisjon. Denne funksjonen krever gjerne litt prøving og feiling. 

En nærmere beskrivelse av hvordan rotasjonsverktøyet fungerer finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Edit_Object#Rotate  

4.3.4 R4: Klipp hull* 

 

Ofte er det behov for å tegne ei flate inne i en annen flate. F.eks. kan det være behov for å tegne en 

liten grønn-figur inne i et gult område, se Figur 9 under. Dette gjøres ofte ved å tegne den grønne 

figuren oppe på den gule flaten. Dette kan se helt OK ut på skjermen, og på en vanlig utskrift, men 

bør likevel ikke gjøres på denne måten. Ved såkalt offset-trykk, eller ved bruk av overtrykkseffekten i 

OCAD, får de overlappende flatene feil farge. I slike tilfeller bør det derfor klippes et hull i den gule-

flaten, som fylles med den ønskede grønne fargen.  

 

Figur 9: Til venstre er det klippet hull til den grønne figuren, men det til høyre ikke er laget hull i den gule flaten. 

Fremgangsmåten for å gjøre dette er som følger: 

 Benytt verktøyet  for å velge flaten som det skal klippes hull i. 

 Velg et av de 8 tegneverktøyene i Figur 2 ved å klikke på en av dem. 

 Klikk på "Klipp hull" knappen  

 Tegn figuren som skal klippes ut av den valgte flaten ved bruk av det valgte tegneverktøyet. 

 Nå er både den opprinnelige flaten og hullet valg. Aktiviser funksjonen  igjen, og klikk 

deretter inne i hullet for kun å aktivisere hullet. 

 Velg så det ønskede fyllflate-symbolet fra symbolregisteret i høyremargen ved å klikke på 

symbolet. 

http://www.ocad.com/en.wiki/index.php?title=Edit_Object#Rotate
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 Klikk på  i verktøylinja for å fylle hullet med det valgte symbolet. 

 Ønskes det et kantsymbol på hull-flaten, velges et ønsket linjesymbol i høyremargen, før det 

klikkes på  knappen på nytt. 

Det kreves litt prøving og feling for å bli kjent med dette verktøyet. En nærmere beskrivelse av 

hvordan man benytter "Klipp hull" funksjonen finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Cut 

eller se følgende instruksjonsvideo: http://www.ocad.com/howtos/31.htm  

4.3.5 R5: Klipp / Del flate* 

 

Brukes til å kutte ei flate i to objekter. Benyttes gjerne når deler av ei flate skal slettes fra kartet. 

Funksjonen benyttes på følgende måte: 

 Benytt verktøyet  for å velge flaten som skal deles 

 Velg et av tegneverktøyene: kurve (T1), rett linje (T6), rektangel (T5) eller frihåndstegning(T7) 

i Figur 2 ved å klikke på en av dem. 

 Klikk på "Del flate" knappen  

 Tegn en linje fra den ene ytterkanten av flaten til den andre ytterkanten av flaten. Flaten vil 

bli da bli delt i 2 av linjen. Merk at kutte-linje-funksjonen ikke kan gå gjennom et hull. 

 Benytt deretter verktøyet  for videre redigering av flatene. 

Det kreves litt prøving og feling for å bli kjent med dette verktøyet. En nærmere beskrivelse av 

hvordan en flate dels / klippes i to finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Cut#Cut_Area 

4.3.6 R6: Klipp linje 

 

Funksjonen benyttes til å klippe ei linje i to eller klippe et opphold i ei linje. Funksjonen med å kutte 

ut et parti av ei linje er blant annet meget nyttig å benytte i forbindelse med tegning av meridianer 

for å fjerne meridianen fra de områdene hvor den forstyrrer lesbarheten. Funksjonen benyttes en del 

i forbindelse med løypelegging, og kutting av postsirkler og strekene mellom postene.  

Klipping av ei linje i to objekter gjøres på følgende måte: 

 Benytt verktøyet  for å velge linjen som skal klippes. 

 Klikk på "Klipp linje" knappen  

 Klikk på linjen der den skal deles. 

Følgende metode benyttes for å klippe ut et parti av ei linje.  

 Benytt verktøyet  for å velge linjen som skal klippes. 

 Klikk på "Klipp linje" knappen  

http://www.ocad.com/en.wiki/index.php?title=Cut
http://www.ocad.com/howtos/31.htm
http://www.ocad.com/en.wiki/index.php?title=Cut#Cut_Area
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 Klikk på startpunktet for der hvor linjen skal få et gap, samtidig som du holder venstre 

musetast nede og flytter musepekeren til sluttpunktet for gapet. Slipp deretter venstre 

musetast.  

 Et opphold i linjeforløpet har nå oppstått. 

En nærmere beskrivelse av hvordan klippe i ei linje finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Cut#Cut_Line 

4.3.7 R7: Parallellforskyv * 

 

Funksjonen benyttes for å flytte ei linje parallelt i forhold til eksisterende posisjon (flytting normalt på 

linjeretningen). Ved bruk av denne funksjonen på kurver med skarpe buer eller flater med store 

retningsendringer kan man oppleve å få kryssende linjer. Vær derfor obs ved bruk av denne 

funksjonen på slike objekter. 

Parallellforskyvningsfunksjonen kan benyttes på to forskjellige måter, enten ved å dra en parallell 

med musepekeren eller å beregne parallellen. Hvordan dette gjøres er nærmere beskrevet i OCADs 

wikiartikkel: 

http://www.ocad.com/en.wiki/index.php?title=Move_Parallel_and_Move_Parallel_with_Distance  

4.3.8 Snu linjeobjekt * 

 

Utover de allerede nevnte funksjonene er "snu linjeobjekt"  funksjonen en av de som man kan ha 

bruk for en gang i blant. Dette gjelder spesielt når man f.eks. har tegnet en skrent, men så havner 

fallstrekene på feil side av linjen. Fallstrekende kan da enkelt flyttes over til den andre siden av 

linjeobjektet på følgende vis: 

 Benytt verktøyet  for å velge skrenten (eller et annet linjeobjekt) som skal speilvendes. 

 Klikk på "Snu linjeobjekt" knappen  

 Fallstrekende har nå byttet hengside av linjen. 

En nærmere beskrivelse av hvordan retningen på ei linje snus finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Edit_Object#Reverse_Object_Direction 

eller se følgende instruksjonsvideo: http://www.ocad.com/howtos/36.htm 

4.3.9 Andre redigeringsverktøy 

 

Det finnes mange flere redigeringsverktøy muligheter i OCAD enn det som er beskrevet i dette 

dokumentet, og en komplett oversikt over de ulike redigeringsmulighetene er å finne i OCAD sin Wiki 

beskrivelse av programmet: http://www.ocad.com/en.wiki/index.php?title=Edit_Object  

4.4 BAKGRUNNSKART 
Når et kart skal tegnes eller redigeres har man som oftest et manuskart (synfaringsnotat eller analogt 

kartgrunnlag) som man tar utgangspunkt i. Resultatet av tegningen/revidering blir klart best om man 

har et bakgrunnskart å tegne etter.  Et godt utgangspunkt for å begynne karttegning eller revidering 

er derfor å legge inn et bakgrunnskart.  

http://www.ocad.com/en.wiki/index.php?title=Cut#Cut_Line
http://www.ocad.com/en.wiki/index.php?title=Move_Parallel_and_Move_Parallel_with_Distance
http://www.ocad.com/en.wiki/index.php?title=Edit_Object#Reverse_Object_Direction
http://www.ocad.com/howtos/36.htm
http://www.ocad.com/en.wiki/index.php?title=Edit_Object
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Før et bakgrunnskart åpnes bør kartet være satt til riktig koordinatsystem (papir-koordinater eller 

terrengkoordinater) og ha riktig målestokk. Hvordan koordinatsystem endres er beskrevet på OCAD 

sine Wiki sider: 

http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Map#Set_Scale_and_Coordinate_Sys

tem 

Dette er spesielt viktig dersom du skal starte på et helt blankt nytt kart. 

Hver oppmerksom på at koordinatsystemets nord-retning ikke alltid sammenfaller med magnetisk 

nord, og at hele kartet dermed må roteres ved bruk av funksjonen, Map > Transform > Rotate Map…, 

for å sette hvor mange grader kartet skal roteres. Husk å fjerne haken fra "Rotate objects with 

symbols orientated to north".  En alternativ metode er å legge inn skrå meridianer, men dette er ikke 

å anbefale. 

To typer bakgrunnskart kan benyttes i OCAD: 

 Geo-referert raster-kart. 

 Ikke geo-referert raster-kart 

4.4.1 Geo-referert raster-kart 

Et geo-referert raster-kart vil si at man har et kartbilde som allerede har koordinater som en del av 

metadataene. Det vil si at bildefilen vet hvor i verden den hører hjemme i et gitt koordinatsystem. 

Geo-refererte rasterkart har gjerne ei ekstra geo-refereringsfil som heter det samme som kartbilde-

fila, men er av en annen filtype. Et *.jpg-bilde vil ha ei geo-refereringsfil med etternavn *.jgw, mens 

et *.tif-bilde vil ha ei tilsvarende fil som heter *.tfw. Et bilde kan også være geo-referert uten å ha ei 

slik fil, da disse dataene er lagret i selve bildefila. OCAD undersøker om bakgrunnsbildet er geo-

referert eller ikke ved åpning av fila. Bildefiler som eksporteres fra OCAD i disse formatene vil være 

geo-refererte. Analoge bakgrunnskart, f.eks. synfaringsnotater, som scannes som tif- eller jpg-filer vil 

ikke ha en slik georeferering. 

Ei geo-referert fil åpnes som bakgrunnskart på følgende måte: 

1. Velg Background Map > Open… fra menylinja, og en dialogboks vises. 

2. Velg bakgrunnskartet som skal åpnes, og klikk OK. 

3. Bakgrunnskartet vil nå automatisk plassere seg på riktig plass i kartet. Hvis kartet mangler 

angitt koordinatsystem vil en dialogboks med valg av koordinat-forskyvning (offset) velges. 

Klikk OK på denne. 

4. Benytt knappen  for å zoome ut slik at hele kartet vises, og kontroller at bakgrunnskartet 

har blitt riktig plassert. 

OCAD-filer kan benyttes som bakgrunnskart og vil automatisk være geo-referert, men det forutsetter 

at begge OCAD-filene har samme koordinatsystem. 

4.4.2 Ikke geo-referert raster-kart 

Når et o-kart skal rentegnes i OCAD har man ofte skannede papirkart som bakgrunnsmateriale. Disse 

har ingen geo-referering. Innpassing av bakgrunnsbildet må gjøres i forbindelse med åpning av 

bakgrunnskartet i OCAD. 

1. Velg Background Map > Open… fra menylinja, og en dialogboks vises. 

2. Velg bakgrunnskartet som skal åpnes, og klikk OK. 

3. Velg oppløsning og målestokk for bakgrunnsbildet, og klikk OK.  

Ved manglende informasjon om oppløsning og målestokk, sett oppløsningen til 200 dpi og 

http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Map#Set_Scale_and_Coordinate_System
http://www.ocad.com/en.wiki/index.php?title=Create_a_New_Map#Set_Scale_and_Coordinate_System
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målestokken til det samme som kartfila. (Oppløsning velges på scanneren når man skanner 

papirkart) 

4. Bakgrunnsbildet åpnes nå sentrert i kartbildet, og må justeres (innpasses) slik at 

bakgrunnskartets posisjon stemmer overens med kartfila. 

Bakgrunnskartet kan enten justeres i henhold til allerede eksisterende objekter i kartfila eller 

kjente terrengkoordinater. Ved bruk av kjente terrengkoordinater som innpassingspunkt bør 

rutenett  aktiveres. 

5. Velg Background Map > Adjust 

6. Klikk på et punkt i bakgrunnskartet som du finner igjen i kartfila (f.eks. en stein) eller har 

koordinatene. 

7. Klikk deretter på det tilsvarende punktet i kartfila eller den kjente koordinatposisjonen. 

8. Gjenta punktene 6 og 7 for alle innpasningspunktene. Det anbefales minimum 4 

innpassingspunkter. Et skjevt bakgrunnkart krever flere innpassingspunkter enn et 

bakgrunnskart som har den samme formasjonen som kartfila. 

9. Når ønsket antall innpassingspunkter er lagt inn, trykk Enter på tastaturet. Bakgrunnskartet 

skal nå komme havne på rett plass i kartfila. 

Ser bakgrunnsbildet rart ut har du sannsynligvis byttet om på rekkefølgen på punkt 6 og 7. Det er da 

anbefalt å trykke «Angre» (Edit > Undo…) og starte på nytt igjen fra punkt 1. Et tips er å velge 

innpassingspunkter fordelt utover hele bakgrunnskartet, og så langt ut mot bildekantene som mulig.  

Mer informasjon om åpning og innpassing av bakgrunnskart finnes her: 

http://www.ocad.com/en.wiki/index.php?title=Background_Map#Open_a_Background_Map 

eller se følgende instruksjonsvideo om hvordan åpne et bakgrunnskart: 

http://www.ocad.com/howtos/71.htm eller hvordan innpasse et bakgrunnskart: 

http://ocad.com/howtos/73.htm 

4.4.3 Bruk av bakgrunnskart 

I ei OCAD fil har man ofte mange ulike bakgrunnskart åpne av gangen. En oversikt over hvilke 

bakgrunnskart som er åpne og tilgjengelige i den åpne kartfila kan sees ved å gå inn på Background 

Map > Manage… Et dialogvindu som i Figur 10 vil åpnes. 

 

Figur 10: Liste over tilgjengelige bakgrunnskart i ei OCAD fil. 

I kolonnen "File name" vises navnene på bakgrunnkartfilene. Parameterne i de fire første kolonnene 

justeres ut fra hvordan bakgrunnskartet ønskes presentert i OCAD-fila. 

 V (Synlighet): Når symbolet  vises i kolonnen er bakgrunnskartet synlig i kartfila. Ved å 

klikke på øye-symbolet forsvinner det fra kolonnen, noe som betyr at bakgrunnskartet ikke 

lengre tegnes opp i kartfila. Bakgrunnskartet kan aktiviseres igjen ved å klikke en gang til i 

kolonnen. 

http://www.ocad.com/en.wiki/index.php?title=Background_Map#Open_a_Background_Map
http://www.ocad.com/howtos/71.htm
http://ocad.com/howtos/73.htm
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Ønsker man å skjule visningen av alle bakgrunnskart kan dette gjøres ved å velge Background 

Map > Hide All. 

 F (Bakgrunnskart-favoritt): Bakgrunnskartet kan settes som et favoritt-bakgrunnskart ved å 

klikke i denne kolonnen. Øye-symbolet er svart når denne funksjonen er aktivert. Denne 

funksjonen har ingen betydning for om et bakgrunnskart blir presentert, eller hvordan det 

blir presentert. 

 Dim (Ned dimming): Det er mulig å gjøre bakgrunnskartet "mindre fremtredende" ved å 

dimme kartet. Verdien 0 betyr at bakgrunnskartet vises i normalfarger, mens 100 betyr at 

bakgrunnskartet blir helt hvitt, og dermed usynlig. 

 T (Transparent): Bakgrunnskartet kan gjøres transparent (gjennomsikt) ved å klikke i denne 

kolonnen. En svart hake vises når bakgrunnskartet er satt transparent. 

Ved å klikke på et av bakgrunnskartene i oversikten i Figur 10, blir bakgrunnskartet markert i blått, og 

kan fjernes for alltid fra prosjektet ved å trykke på Remove-knappen.  

4.5 IMPORT AV DIGITALT KARTGRUNNLAG 
I de tilfellende hvor man har tilgang til digitale kartdata, vektordata, over området er dette et godt 

utgangspunkt for videre tegning og redigering. Vektordata kan fås ved å ta kontakt med kommunen 

hvor o-kartet fysisk ligger.  Mer informasjon om hvordan man går frem for å få tak i vektordata finnes 

her: http://www.orientering.no/arrangor/kart/Sider/Kartdata.aspx. OCAD kan importere flere ulike 

filformater, men i de fleste tilfeller anbefales dxf-formatet. 

Hvis man har vært ute i terrenget og målt punkter med GPS, så kan disse punktene importeres i 

OCAD ved bruk av ei GPX-fil. Det som er viktig å være klar ved bruk av slike GPS målinger er at 

unøyaktigheten på punktene stort sett er mellom 5-10 meter. Hvis punktene er målt i veldig kupert 

terreng eller tett skog kan nøyaktigheten på punktene være enda dårligere. Denne metoden er 

derfor lite egnet for pre-o-revidering. 

Generelt for digitale kartfiler er at de importeres på følgende måte: 

 Velg File > Import…  

 En dialogboks åpnes og ønsket import fil velges. Alle filtyper som det er mulig å importere vil 

vises i dialogboksen. 

 Klikk på Open  

Hva som videre må gjøres for å importere fil avhenger av filtypen som skal importeres. En nærmere 

beskrivelse av hvordan de ulike filtypene importeres er å finne i OCADs Wiki bruksangivelse: 

http://www.ocad.com/en.wiki/index.php?title=Import_Files  

  

http://www.orientering.no/arrangor/kart/Sider/Kartdata.aspx
http://en.wikipedia.org/wiki/Dxf
http://www.ocad.com/en.wiki/index.php?title=Import_Files
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Følgende instruksjonsvideoer finnes for import av GPX-filer 

Import GPX-fil http://ocad.com/howtos/10.htm  

Importer GPS data (way points and tracks) 
fra Garmin eTrex 

http://ocad.com/howtos/12.htm  

Analyser dine GPS spor http://ocad.com/howtos/114_import_gpx_ocadcs.htm  

 

http://ocad.com/howtos/10.htm
http://ocad.com/howtos/12.htm
http://ocad.com/howtos/114_import_gpx_ocadcs.htm
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5 FRA FOT-O-KART TIL PRE-O-KART 

Når man skal bruke et ordinært fot-o-kart til et pre-o-arrangement må kartet gjennom en 

konverteringsprosess for å passe de normer som gjelder for pre-o-kart. Forskjellene gjelder 

hovedsakelig målestokken på kartet og størrelsen på symbolene i kartet. Dersom originalkartet er et 

sprintkart tegnet etter sprintnormen (ISSOM) så er ingen av stegene i dette kapittelet nødvendig. 

Merk at konverteringsprosessen i dette kapittelet kommer i tillegg til revideringen av kartet i og 

rundt traseen som skal brukes til arrangementet. 

Dette kapittelet viser hvordan konverteringsprosessen for ordinære fot-o-kart gjøres i OCAD 11 og 

består av følgende trinn: 

1. Skape kartutsnitt av originalkartet 

2. Endre målestokk på kartet 

3. Skalere symboler 

4. Legge inn tettere meridianer 

HUSK: Det er veldig viktig at man lagrer ofte. Med jevne mellomrom bør man også lagre filen med 

nytt navn, File > Save As… (f.eks. «dette_er_min_fil_versjon_xxxx.ocd») slik at man kan gå tilbake 

dersom man gjør feil. 

5.1 SKAPE KARTUTSNITT AV ORIGINALKARTET 
Når man skal bruke kun en liten del av et større o-kart til en pre-

o-konkurranse er det en fordel å lage et utsnitt svarende til den 

delen av det fullstendige o-kartet man skal bruke og kun jobbe 

videre med dette utsnittet. Det gjør kartfilen mer håndterlig og 

lettere å jobbe med.  

For å lage et slikt kartutsnitt, gjør man som følger: 

1. Velg  Map > Export Part of Map…  på menylinja. 

2. Velg her «Rectangle» i menyen til høyre (Figur 12).  

3. Dersom du ikke ser hele området du vil lage utsnitt av, 

trykk på knappen for «Show entire map» i 

hovedmenylinja (Figur 11).  

4. Velg deretter knappen for «Entire map» i menyen til 

høyre (Figur 12). Et sort rektangel legger seg da rundt 

hele kartet. 

5. Dra så i hjørnene på dette rektangelet slik at det passer 

med det området du ønsker kartutsnitt av. (Bruk gjerne 

zoom og navigeringsverktøyene for å plassere 

rektangelet presist.)  

6. Avslutt med «OK» og lagre kartet ved ønsket plassering.  

7. Lukk så det opprinnelige o-kartet uten å lagre og åpne 

det nye kartutsnittet du akkurat har lagret for å jobbe 

videre med dette (via File > Open… på menylinja). 

 

Figur 11: Tegn hele kartet ved å trykke på 
knappen "Show Entire Map" 

Figur 12: Entire map 
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5.2 ENDRE MÅLESTOKK PÅ KARTET 
Det viktigste momentet i konverteringsprosessen er å endre målestokken til den du skal ha på 

konkurransekartet. 

Målestokken på kartet endres som følger: 

1. Velg Map > Change map scale fra menylinja. 

2. Den nye ønskede målestokken velges i 

nedtrekkesmenyen ved «New scale».  

3. Fjern deretter krysset foran 

«Enlarge/reduce symbols» (Viktig(!)) (Se 

Figur 13).  

4. Avslutt med «OK».  

Siden alle symboler nå skaleres vil du umiddelbart 

se at avstandene mellom detaljene blir større på skjermen, og det kan se ut som om symbolene har 

krympet (sistnevnte er ikke tilfellet i praksis). 

Ved nedskalering av symboler kan man oppleve at det blir gap mellom flater og linjeobjekter (f.eks. 

mot veger), hvor flatene opprinnelig fulgte vegkanten. Ved nedskalering av symbolene vil linjene bli 

smalere, mens utstrekningen av flatene blir uforandret, se eksempel i Figur 14 under.  

 

Figur 14: Gap kan oppstå ved endring av målestokk, uten å justere størrelsen og plasseringen til symbolene. Øverst er 
originalkartet og nedenfor er versjonen med skalerte symboler. Merk spesielt den lille avstikkeren på bilveien og avstanden 

fra myrsiget til bilveien. 

Figur 13: Endre målestokk. Slik skal vinduet se ut når man 
endrer fra 1:10000 til 1:5000 
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Figur 15: Slik skalerer man alle symbolene når originalkartet 
var et 1:7500-kart. 

5.3 SKALERE SYMBOLER 
For at symbolene ikke skal bli veldig store på konkurransekartet så må man skalere symbolene etter 

at man har endret målestokken. I følge de nordiske (og internasjonale) retningslinjene skal 

symbolstørrelsene være 150 % av størrelsen på et 1:15000-kart når konkurransekartet er i målestokk 

1:5000 eller 1:4000. Dette svarer til uforandret symbolstørrelse på kartet når originalkartet var i 

målestokk 1:10000, tegnet etter ISOM og skalert på ordinært vis.  

Dersom det opprinnelige kartet man endret målestokken på i kapittel 5.2 var i målestokk 1:10000 er 

alt som det skal være siden størrelsen på symbolene ikke ble endret når krysset «Enlarge/reduce 

symbols» var fjernet. Man behøver da altså ikke å foreta noen ekstra skalering i dette punktet.  

Dersom originalkartet var i en annen målestokk må man endre symbolstørrelsen. I Tabell 1 nedenfor 

ser du skaleringsfaktorene som skal brukes når originalkartet er i ulike målestokker og har fulgt 

standard skalering i forhold til ISOM. Skaleringen utføres da som følger: 

1. Velge Symbol > Enlarge/Reduce på menylinja.  

2. Kryss av for «All symbols» og velg ønsket skaleringsfaktor (se eksempel i Figur 15). 

3. Avslutt med «OK». 

Skal konkurransekartet være i målestokk 1:3000 eller større kan man med fordel øke 

symbolstørrelsen noen prosent, men dette bør i så 

fall opplyses i PM. 

 

Målestokk 
originalkart 

Skaleringsfaktor 

1:15000 150 % 

1:10000 100 % (ingen skalering) 

1:7500 75 % 
 Tabell 1:Skaleringsfaktorer for ulike målestokker. 

5.4 LEGGE INN TETTERE MERIDIANER 
 

Når man forstørrer et kart vil avstandene mellom meridianene i praksis økes. Spesielt for pre-o er det 

viktig å ha tette meridianer for å gjøre det enklere å blant annet ta kompasskurs.  

ISSOM (sprintkartnormen) spesifiserer at det skal være 150m mellom hver meridian. Vi anbefaler 

samme meridiantetthet på pre-o-kart.   

Siden det ligger meridianer inne på kartet fra før av må disse fjernes før man legger inn nye. Dersom 

man prøver å fjerne disse manuelt er det fort gjort også å fjerne andre detaljer. Dermed anbefales 

det at man fjerner meridianene på følgende vis: 
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1. Finn fram til symbolet som brukes 

til meridianene i symbollista til 

høyre og velg dette ved å klikke på 

symbolet. Vanligvis er dette en sort 

eller blå vertikal strek . 

2. Velg så Select > Select Objects by 

Symbol… 

3. I vinduet som dukker opp velger du 

«All objects with a selected 

symbol» og trykker på «OK». 

4. Meridianene på kartet vil nå være 

valgt. Trykk da på «Delete» på 

tasteturet og meridianene vil 

forsvinne. 

Det er nå klart for å legge inn nye tettere 

meridianer. Før man legger inn selve 

meridianene må man sørge for at man har 

satt koordinatsystemet til terreng-

koordinater. Dette gjøres som følger: 

1. Velg Map > Set Scale and Coordinate 

System 

2. Huk av for «Real world coordinates» under «Coordinates» dersom dette ikke allerede er 

gjort. La de øvrige innstillingene stå slik de er og avslutt med «OK». 

For å legge inn selve meridianene, gjør som følger: 

1. Velg Map > Create Map Grid… på menylinja.  

2. Under «Easting distance» skriv inn 150m.  

3. Fjern så krysset foran «Create easting grid lines» 

4. La det være kryss foran «Create northing grid lines».  

5. Under «Graticule lines» velg meridiansymbolet i nedtrekksmenyen.  

6. Vinduet skal nå se ut som på Figur 16, trykk så OK og du vil se at meridianene er lagt inn i 

kartet. 

  

Figur 16: Slik skal vinduet for innlegging av meridianer se ut. 
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6 OM UTSKRIFT OG EKSPORT AV KART 

 

Når kartet er klargjort for pre-o er det tid for å skrive det ut i ønsket målestokk før det kartrevidering 

spesifikk for pre-o-konkurransen. For kompletthetens skyld tar vi her også med hvordan man 

eksporterer kartet til enten en bildefil (jpeg, png,…) eller pdf.  

Når man skal revidere eller synfare er det nyttig å skrive ut kartet i større målestokk enn det man skal 

ha. For 1:5000 og 1:4000 kart er det passende å revidere kartet i målestokk 1:2000. 

Før man skriver ut eller eksporterer kart er det imidlertid viktig at man fjerner alle aktiverte 

bakgrunnsbilder man ikke ønsker at skal være med på utskriften/eksporten. Hvordan dette gjøres er 

forklart i kapittel  4.4.3, Bruk av bakgrunnskart. Skal man skrive ut eller eksportere et kart uten 

bakgrunnsbilder så må man forsikre deg om at man befinner seg i «Normal mode». For å velge 

normal mode, gå til View > Normal Mode på menylinja. 

I enkelte tilfeller kan det være ønskelig å skrive ut eller eksportere kartet med et bakgrunnsbilde eller 

kart som kun vises delvis. Før du går videre bør du da velge View > Draft mode på menylinja og still 

på målerne som dukker opp på verktøylinja  

 helt til kart og bakgrunnsbilde vises slik 

du ønsker på skjermen. Eksport til pdf fra «Draft mode» er 

ikke mulig. 

6.1 UTSKRIFT AV KART 
 

For å skrive ut et kart gjør man som følger: 

1. Trykk File > Print på menylinja. 

2. Velg ønsket printer og antall kopier øverst i vinduet 

som dukker opp. 

3. Velg «Portrait» (stående) eller «Landscape» 

(liggende) utskrift etter ønske. 

4. Velg ønsket utskriftsmålestokk under «Print scale» 

5. Under «Print map size» velger du «One page». 

6. Flytt så rektangelet til ønsket utskriftområde ved å 

dra i sidene på rektangelet (ikke hjørnene). Om du 

ønsker et mindre utskriftområde velger du «Part of 

map» under «Print map size» og justerer størrelsen 

på ved å dra i hjørnene på rektangelet i 

hovedvinduet. 

7. La de øvrige innstillingene stå (se Figur 17) slik de 

var og trykk «Print». (Merk spesielt at «Print screen 

grid» ikke skal være valgt under «Options».) 

6.2 EKSPORT AV KART 
 

Det kan ofte være nyttig å eksportere kartet til et annet format. For eksempel er dette nyttig om 

noen som ikke har OCAD-fila skal se kartet eller om det skal legges ut på internett. De to 

Figur 17: Innstillinger for printing 



26 
 

hovedformatene er jpeg (bildefil) og pdf (grafikkfil). Kvaliteten beholdes best om man bruker pdf, og 

dette formatet er også best egnet til en eventuell senere utskrift.  

 

Eksport av kart gjøres som følger: 

1. Trykk File> Export på menylinja. 

2. Velg ønsket format i nedtrekksmenyen øverst i menyen til høyre.  

3. For jpeg anbefales det å sette «Resolution» til minst 200 dpi (jo høyere dpi jo bedre kvalitet, 

men jo større filstørrelse). 

4. Kryss av for «Part of map» og velg enten «A4 Landscape» eller «A4 Portrait» fra 

nedtrekksmenyen. 

5. Dra rektangelet til ønsket eksportområde (ikke i hjørnene). Om du ønsker et mindre eller 

større eksportområde kan du dra i hjørnene på rektangelet for å endre dette, men merk at 

man da kan få problemer med senere utskrift. 

6. For pdf kan man også velge annen eksportmålestokk under «Export scale». OBS: Dersom 

«pdf» ikke vises i nedtrekksmenyen skyldes det trolig at du ikke har valgt «Normal Mode» 

under View > Normal mode på menylinja. 

7. La øvrige innstillinger stå slik de er (se Figur 18 for jpeg og Figur 19 for pdf), trykk «Export» og 

lagre filen på ønsket sted. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figur 18: Eksport av jpg-bilde 

Figur 19: Eksport av ei pdf-fil 
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Merk at det sterkt anbefales at man skriver ut konkurransekart og kart for synfaring direkte fra 

OCAD for best resultat. Da kan man være helt sikker på at målestokken blir korrekt, noe man ikke 

kan være om man går via andre formater og programmer for utskrift. 
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7 LØYPELEGGING FOR PRE-O 

Det praktiske arbeidet med å legge løyper på datamaskinen for pre-o kan gjøres på omtrent samme 

måte som for vanlig fot-orientering. Det finne ulike programmer som gjør denne jobben, men de 

aller fleste bruker OCAD også til dette. Å bruke OCAD til løypelegging for pre-o er da også en fordel 

siden man har fleksibiliteten til å legge inn postbeskrivelser for pre-o, skjule tidspostområder og 

diverse annet pre-o-spesifikt i et og samme program. Dette kapittelet viser hvordan man legger en 

pre-o-løype i OCAD 11 steg for steg ved å ta utgangspunkt i OCADs egen løypeleggingsfil for pre-o 

(finnes i OCAD 10 og 11). Disse må benyttes for å kunne lage postbeskrivelser med «A, A-B, A-C,…». 

Stegene består av følgende hovedmomenter: 

1. Åpne og klargjøre løypeleggingsfila 

2. Laste inn kartfilen som bakgrunn 

3. Opprette ny løype 

4. Sette inn løypeobjekter 

5. Sette sammen løype 

6. Lage og sette inn postbeskrivelse 

7. Visuell behandling 

8. Layout 

9. Kutte streker og postsirkler 

10. Utskrift/eksport av løype 

 

HUSK: Det er veldig viktig at man lagrer ofte. Med jevne mellomrom bør man også lagre filen med 

nytt navn (f.eks. «dette_er_min_fil_versjon_xxxx.ocd») slik at man kan gå tilbake dersom man gjør 

feil. 

7.1 ÅPNE OG KLARGJØRE LØYPELEGGINGSFIL 
For å legge pre-o-løyper i OCAD må man bruke en bestemte løypeleggingsfil. For å starte med pre-o-

løypleggingen gjør man som følger: 

1. Velg File > New… på menylinja. 

2. Velg «Course setting project for orienteering» under «Map type» og velg deretter «Course 

setting Trail and Macro Orienteering 5000» under «Load symbol set from» og avslutt med 

«OK». 

Den innebygde løypelegginsfila er som navnet tilsier beregnet på løypelegging i målestokk 1:5000. 

Om pre-o-kartet har en annen målestokk må man derfor endre på dette. Det gjøres som følger: 

1. Velge Map > Change scale på menylinja.  

2. Skriv inn riktig målestokk under «New scale» og la «Enlarge/reduce symbols» stå uten hake 

(viktig!) 

3. Avslutt med «OK».  

7.2 LAST INN KARTFILA SOM BAKGRUNNSFIL 
For å legge en løype på et kart må man laste inn pre-o-kartet som en bakgrunnsfil.  Det gjøres som 

følger: 

1. Velg Background Map > Open… på menylinja. 
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2. Finn så fram til den kartfila for pre-o-kartet der du har lagret den på maskinen din og åpne 

dette. 

3. Velg «OK» på eventuelle vinduer som dukker opp. 

4. Trykk på «Show entire map» på verktøylinja ( ) (ev. via View > Show entire map) for å vise 

hele kartet. 

Man skal nå se konkurransekartet som vanlig midt på skjermen. 

7.3 OPPRETT NY LØYPE 
Før man kan starte på selve løypeleggingen må man opprette løyper. Dette gjøres som følger: 

1. Velg Course setting > Courses på menylinja. 

2. Velg så «Add» nederst på vinduet som dukker opp. 

3. Skriv inn navnet på løypa du skal opprette (f.eks. «Elite» ). 

4. Gjenta punkt 2 og 3 til du har lagt inn alle løypene til konkurransen. 

5. Trykk så «OK». 

7.4 SETTE INN LØYPEOBJEKTER 
Det er nå klart for å starte selve løypeleggingen. Den første  

delen av denne prosessen består av å legge inn starttrekanter,  

poster, målgangsamt eventuelle avkryssede stier. Dette gjøres  

som følger: 

1. Velg ønsket løypeobjekt i vinduet til høyre: Start, 

Control point, Finish eller Forbidden route som vist i 

Figur 20. 

2. Velg et tegneobjekt, f.eks.  

3. Zoom så godt inn på det området der man vil plassere 

objektet og trykk nøyaktig der du ønsker sentrum 

objektet. (Det er veldig viktig at man zoomer langt nok 

inn før man plasserer sirkelsentrum for at posten skal 

plasseres nøyaktig der den skal. Zoom gjerne så langt 

inn som det er mulig i OCAD.) 

4. Et vindu der man skal skrive inn koden til objektet dukker så opp. Velg bare «OK» her da 

denne koden ikke har noen betydning. 

5. Objektene kan flyttes etter plassering med den hvite pila som ved vanlige kartobjekter.  

Eventuell merket rute settes inn ved å bruke symbolet for merket rute:  

7.5 SETTE SAMMEN EN LØYPE 
Når man har satt inn løypeobjektene fra punktet over er det klart 

for å sette dem sammen til en løype. Dette gjøres som følger: 

1. I nedtrekksmenyen under «Course» i høyre meny velges  

den løypa man vil sette sammen (se Figur 21). 

2. Velg «hvit» pil  på verktøylinja og trykk én gang 

Start

 

Post

 

Mål

 

Forbudt sti

 

Figur 20: Symboloversikt, pre-o løypelegging 

Figur 21: Velg løype 
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omtrent i midten på starttrekanten du ønsker å legge til (i hovedvinduet). (OBS: Pass på så du 

ikke flytter objektet når du klikker på det.) Objektets navn markeres nå med blått i kolonnen i 

menyen til høyre (markert med grønn sirkel i Figur 22). Dobbeltklikk på objektet i denne lista 

for å legge det til. Du vil se at objektets kode dukker opp i lista for denne løypa nederst 

(markert med rød sirkel i Figur 22.) 

3. For å legge til poster og mål gjøres akkurat det samme som for starttrekanten. Objektene vil 

legge seg i den rekkefølgen de legges til. 

4. For å legge til et objekt midt mellom to eksisterende objekter trykker du mellom de to 

eksisterende objektene i løypelista (markert med rødt i figur 3). (Om du f.eks. vil legge til en 

ny post 6 mellom eksisterende post 5 og 6.) En blå strek vil da legge seg mellom disse, og når 

du nå legger til et nytt objekt som forklart i punkt 2 vil dette plassere seg der. 

5. For å fjerne et objekt fra en løype trykker man på dette objektet i løypelista (markert med 

rød sirkel i Figur 22) slik at objektet markeres med blått. Trykk så på «delete»-knappen på 

tastaturet for å fjerne objektet fra løypa. 

For å se hvordan den sammensatte løypa ser ut velges «Preview» under «Course» i vinduet til høyre.  

Dersom arrangementet har flere løyper setter man sammen de andre løypene på samme måte. Merk 

at samme post gjerne kan inngå i flere løyper.  

7.6 LAGE OG SETTE INN POSTBESKRIVELSE 
Når man har lagt inn poster og satt dem sammen til løyper er det tid for å lage og legge inn 

postbeskrivelser. For å spesifisere postbeskrivelsen til en enkeltpost gjør man som følger: 

1. Velg «hvit» pil  på verktøylinja og trykk én gang omtrent i midten på posten du ønsker å 

legge til (i hovedvinduet). OBS: Pass på så du ikke flytter objektet når du klikker på det. 

Posten du har valgt er markert med blått i kolonnen markert med grønt i Figur 22.  

Figur 22: Velg et objekt fra listen 
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2. For å velge antall skjermer for denne posten/oppgaven, 

trykk en gang på postnummeret under «Object» i 

vinduet til høyre og velg A, A-B, … A-E, svarende til 

antall skjermer for denne oppgaven. 

3. For å legge inn postbeskrivelse i de andre rutene trykker 

man rett og slett i de rutene man vil endre og velger det 

symbolet man vil sette inn. (Se Figur 23) 

Når man har laget slike postbeskrivelser for alle postene til alle 

løypene er det tid for å plassere postbeskrivelsen på kartet. 

Dette gjøres som følger: 

1. Velg symbolet «Control Description Upper left»  i 

symbollista øverst i vinduet til høyre.  Symbolet ser slik 

ut: 

2. Velg et tegneverktøy, f.eks.  fra verktøylinja. 

3. Trykk der du ønsker at det øvre venstre hjørnet av postbeskrivelsen skal være på kartet.  

4. Du vil ikke se postbeskrivelsen før du viser løypa med «Preview» under «courses» i vinduet til 

høyre. 

7.7 LEGGE INN TRASÉLENGDE OG MAKSTID 
Øverst på postbeskrivelsen skal det i tillegg til løypenavn stå oppført lengden på løypa (langs traseen 

man benytter) og makstid. For å kunne føre inn dette må man først vite hvor langt man beveger seg 

mellom siktepinnene. Dette kan man måle digitalt som følger: 

1. Velg et linjesymbol i symbollista øverst i vinduet til høyre. F.eks. «Uncrossable boundry» (

). 

2. Velg så tegneverktøy, f.eks.    og tegn så en punktvis linje som følger korteste avstand fra 

startepunkt, på vei/sti mellom der du planlegger å ha siktepinnene og til mål.  

3. Når dette er gjort velger du målesymbolet  på verktøylinja. Lengden på linja står så 

oppførst under «Line length - Real world».  

4. Husk å slette objektet du har brukt til målingen etter at målingen  er utført. Dette gjøres som 

vanlig ved å velge dette objektet med hvit eller sort redigerinspil  og trykke 

«delete»-tasten på tasteturet når dette er valgt. 

Makstiden beregnes nå ved standard formel (makstid i minutter = antall påbegynte 100-metere 

ganger 3 + antall poster ganger 3).  

For å føre informasjon om lengde og makstid inn på kartet må man trikse litt siden det som standard 

ikke er noen rubrikk for makstid og løypelengden som settes inn automatisk beregnes ut ifra korteste 

avstand mellom sirkelsentrum i luftlinje.  

Innlegging av korrekt trasélengde gjøres som følger: 

1. Velg Course setting > Courses i menylinja.  

2. På linje med hver løype ser du lengden på løypa. For å få korrekt traselengde på 

postbeskrivelsen må man legge til eller trekke fra differansen mellom dette tallet og 

Figur 23: Sett inn postbeskrivelse 
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trasélengden. Det gjøres ved å skrive inn differansen (eller bruke pilene som dukker opp) 

etter at man har trykket i rubrikken for ønsket løype i kolonnen «Extra length». Dette må 

gjøres for hver av løypene. 

3. Avslutt med «OK». 

Makstiden vil vi plassere der antall høydemetre normalt er plassert på postbeskrivelsen. Det fikses 

som følger: 

1. Velg Course setting > Courses i menylinja.  

2. I kolonnen for «Height climb used» trykker man og skriver inn antall minutter for makstiden 

for hver av løypene på samme måte som for trasélengden.  

3. Avslutt med OK. 

Merk at det i postbeskrivelsen vil stå «m» bak makstiden. Det er fordi vi har brukt rubrikken til noe 

annet enn den er ment å brukes til. Om man synes dette ser stygt ut kan man alternativt skrive 

makstiden et annet sted på kartet som vanlig skrift som beskrevet i punkt kapittel 7.9 nedenfor. 

7.8 VISUELL BEHANDLING 
 

Vi har nå gått gjennom hovedskrittene for å legge en komplett pre-o-løype i OCAD. For at kartet skal 

fremstå slik man ønsker er det imidlertid noen småting som bør fikses på: 

1. Dersom området som skal brukes til tidspostene etter løypa er synlige på kartet med løypa 

bør må man skjule dette området. Det gjøres ved å velge symbolet «White background» (

) i symbollista i menyen til høyre. Velg så et arealtegnesymbol (f.eks.: «Cirlce mode» 

) og lag et hvitt areal over tidspostområdet.  

2. Postbeskrivelsen på kartet vil som standard vises som én lang liste. Dersom man ønsker å 

dele opp postbeskrivelsen i flere kolonner, gå til Course setting > Options… på menylinja. Sett 

så «Maximum length» til ønsket antall rader under «Control Description» øverst til høyre i 

vinduet som dukker opp. Avslutt med «OK». 

 

7.9 LAYOUT 
Det er ofte fint å ha en ramme rundt kartet man skal skrive ut og det er også nyttig å kunne vise 

diverse kart- og løpsinformasjon på kartet. For å gjøre dette vil vi importere enn layoutfil med diverse 

verktøy. Siden den enkleste måten å gjøre dette på ikke er tilgjengelig i OCAD 10 vil vi presentere to 

ulike metoder, én kun for OCAD 11 (den greieste) og en som er mulig i både OCAD 10 og 11. 

7.9.1 Metode 1 (OCAD 11) 

 Vi skal nå importere en layoutfil. Før man importerer filer så må man gå ut av «preview mode» om 

man skulle valgt denne. Det gjøres ved å trykke på «Preview» under «Course» en gang til slik at løypa 

ikke forhåndsvises lenger. Følg deretter følgende prosedyre:  

1. Gå til File > Import… på menylinja. 

2. Finn fram til der du har lagret mal-filene tilhørende denne dokumentasjonen, velg en av 

filene «Layout_A4_liggende.ocd» eller «Layout_A4_stående.ocd» avhengig av om du ønsker 

en stående eller liggende ramme og avslutt med «Open». 
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3. I vinduet som dukker opp 

skal følgende punkter stå 

som valgt: «Place using 

Mouse» under «Position», 

«Import all symbols and 

colors» under «Symbols» 

og «Import colors at the 

top of the color table» 

under «Colors». I tillegg 

skal «Change symbol status 

from normal to protected» 

ikke være valgt. Vinduet 

skal altså se ut som vist i 

Figur 24. Avslutt med «OK».   

4. Ramma vil nå komme til 

syne på kartet med et hvitt 

dekke rundt. Ramma vil 

også være merket slik at du 

kan flytte den til ønsket 

plassering med en gang. 

5. Når ramma er plassert der 

den skal stå så trykker man 

et vilkårlig sted utenfor 

ramma. 

6. Siden ramma er tilpasset 

utskrift i A4-format er det viktig at du ikke justerer på størrelsen på den. For at ikke det skal 

skje ufrivillig så er det lurt å beskytte den. Det gjøres ved å høyreklikke på det nye 

rammesymbolet ( ) i menyen til venstre og velger «Protect». Gjenta det samme med 

symbolet ved siden av ( ) som er symbolet for den hvite ramma rundt der igjen. Når dette 

er gjort er det ikke mulig å endre på disse objektene på kartet lenger (uten å oppheve 

beskyttelsen). 

Sammen med rammesymbolet ble en del symboler for å lage et penere kart importert i OCAD-fila. 

Disse ligger nederst i symbolsettet. Symbolene som viser en T og et tall er tekstsymboler man kan 

skrive på kartet med. I tillegg er det et utvalg logoer som man kan legge på om man ønsker det. 

Spesielt kan det være greit å skrive inn kartinformasjon som målestokk og ekvidistanse på 

konkurransekartet samt annen kartinfo, navn på kartet osv. Slik info legges inn på kartet på følgende 

vis: 

1. Dersom det ikke allerede er hvitt der du ønsker å legge inn informasjonen bør du legge på 

hvit bakgrunn på dette området ved å bruke symbolet for hvit bakgrunn ( ) på vanlig vis 

(beskrevet f.eks. i 7.8 - Visuell behandling). 

2. For å skrive på kartet velges nå en av symbolene merket med en T og et tall i høyre hjørne: 

 Størrelse 18 er som regel passende. 

3. Velg så et tegnesymbol, f.eks.  og trykk der du ønsker å begynne å skrive, og skriv inn 

ønsket tekst. «Enter» på tastaturet gir som vanlig linjeskift. 

Figur 24: Import av ramme 



34 
 

For å legge inn en logo i en løypeleggingsfil må man først velge at disse ikke skal være 

løypeleggingsobjekter. Det gjøres ved å høyreklikke på logoen, velge «Edit…» og så velge «Not used 

for course setting» under «Course setting project for orienteering». Når det er gjort kan man sett inn 

logoene som ordinære punktobjekter.  Om man ønsker å justere størrelsen på en logo kan dette 

gjøres på vanlig vis ved å høyreklikke på det aktuelle symbolet i vinduet til høyre, og velge 

«Enlarge/reduce» for så å skrive inn skaleringsfaktoren etterfulgt av «OK». 

7.9.2 Metode 2 (OCAD 10) 

Som nevnt er metode 1 ikke mulig å bruke i OCAD 10 fordi Import-funksjonen der ikke finnes i 

løypeleggingsmodus. Vi må derfor legge inn ramma og eventuelle logoer på selve pre-o-kartet og kan 

da likeså godt gjøre de øvrige Layoutmessige stegene direkte på pre-o-kartet som vi bruker som 

bakgrunnskart. Dette gjøres som følger: 

1. Gå til File > Open… og åpne pre-o-kartet du nå har brukt som bakgrunnskart. (Det kan være 

lurt å ta en kopi av pre-o-kartet før du gjør dette siden vi skal overskrive det gamle kartet) 

2. Følg så hele prosedyren i punkt 7.9.1 - Metode 1 (OCAD 11), bortsett fra at man ikke trenger 

å gjøre noe med logoene før man setter de inn på kartet slik det er beskrevet i siste avsnitt – 

disse kan settes rett inn som ordinære punktobjekter. 

3. Når kartet er klart layoutmessig lagrer du kartet (uten å endre navn). 

4. Når du nå går tilbake til løypeleggingsfila vil du se at bakgrunnskartet er blitt oppdatert med 

de layoutmessige endringene som er gjort. 

7.10 KUTTE STREKER OG POSTSIRKLER 
Når alle løypene er komponert er det tid for den siste finpussen, nemlig å kutte postsirkler og streker 

mellom postene som er i veien for detaljer som er av betydning for utøverne. Spesielt er dette viktig 

å gjøre når to sirkler er så nære at de krysser hverandre. Dette bør gjøres helt til slutt grunnet at 

dersom man flytter på postersirkler etter at postsirkler er kuttet vil ikke de kuttede sirklene passe 

lenger og man må gjøre det hele på nytt for de postene man flytter på. Før man kutter postsirkler og 

streker er det lurt å flytte eventuelle postnummer på kartet som er i veien.  

Prosessen må gjennomføres på hver enkelt post og løype og går som følger: 

1. Velg løype du ønsker å flytte postnumre og klippe postsirkler og -streker for under «Course» i 

vinduet til høyre. Velg så «Preview» rett nedenfor. 

2. For å flytte på postnumre som er i veien, trykk en gang på tallet du vil flytte og flytt dette ved 

å trykke og dra i det lille kvadratet som dukker opp i nedre venstre hjørne av tallet. Husk at 

det ikke må være noen tvil om hvilket tall som hører til hvilken sirkel. 

3. For å kutte postsirkler, går man først ut av «previewmodus» ved å trykke på «Preview» en 

gang til under «Course» i vinduet til høyre. Velg så «hvit» editeringspil ( ) og trykk en gang 

omtrent på midten på den sirkelen du ønsker å kutte sirkelen på. Velg deretter 

klippeverktøyet ( ). Man zoomer så godt inn på den posten man skal klippe på, og trykker 

og holder inne museknappen der man vil starte å klippe i postsirkelen. Dra musepilen (mens 

du fortsatt holder museknappen inne) bort til der oppholdet i postsirkelen skal ende og slipp 

museknappen. Dette gjentas om man ønsker flere hull i samme postsirkel. Gjenta det samme 

for alle postsirkler som skal klippes. 

4. For å kutte streker mellom poster velger man igjen «Preview» under «Course» i vinduet til 

høyre. Velg så hvit editeringspil ( ) og trykk en gang et vilkårlig sted på den streken som 

skal klippes. Velg deretter klippeverktøyet ( ). Nå gjøres akkurat det samme som ved 
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klipping av postsirkler: Trykk og hold inn museknappen der du vil starte å klippe. Dra 

musepilen (mens du fortsatt holder museknappen inne) bort til der oppholdet skal slutte og 

slipp museknappen. Merk at dersom du skal ha et opphold i en av endene så må(!) du i 

stedet velge den enden som skal flyttes ved den hvite editeringspila ( ) og flytte denne 

ved å trykke holde inne og dra. 

OBS: Dersom en sirkel brukes i flere løyper og kun den ene løypa skal ha en kuttet sirkel (eller 

kuttingen skal være forskjellig for de to løypene) så bør det legges inn to ulike postsirkler med 

samme sentrum. Grunnen til dette er at kuttingen følger symbolet og ikke løypa. 

 

Nedenfor er et eksempel på før og etter klipping av postsirkler, streker og flytting av numre: 

 

Figur 25: Før editering 



36 
 

 

Figur 26: Etter editering 

7.11 UTSKRIFT/EKSPORT AV LØYPEKART 
 

Utskrift og eksport av løypekart er minimalt forskjellig fra utskrift og eksport av vanlige kart fra 

OCAD, som dokumentert i kapittel 6 "Om utskrift og eksport av kart". Når man skal skrive ut 

løypekart bør man imidlertid velge utskrift fra Course setting menyen i stedet for å gjøre dette via 

File-menyen. Utskrift av løypekart gjøres altså som følger: 

1. Velg Course setting > Print > Courses på menylinja 

2. Man vil nå få opp den vanlige utskriftsmenyen med tilleggsmenyen «Select Courses/Classes» 

nederst. Velg der hvilke(n) av løypene du vil skrive ut. 

3. Følges de øvrige skrittene i punkt 6.1 -  Utskrift av kart.  

For å eksportere et løypekart så går man direkte til File > Export… og følger de vanlige trinnene for 

eksport i ulike format gitt i punkt 6.2 - Eksport av kart.  
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8 LØSNINGSKART FOR PRE-O 

Som et supplement til den obligatoriske fasiten i en pre-o-konkurranse har det blitt stadig vanligere å 

lage såkalte løsningskart, spesielt i eliteklassen. Et slikt kart viser hvor alle skjermene tilhørende alle 

oppgavene (inkludert tidspostene) er plassert. Kartet er nyttig for utøverne for å finne ut hva de har 

gjort feil og det gir definitivt bedre diskusjoner etter konkurransen. Kartet kan også være nyttig for 

løypelegger for å få et overblikk over oppgavene han/hun har lagt. 

Det finnes flere ulike varianter av løsningskart og det er mange måter å lage dem på. Akkurat 

hvordan man lager løsningskartet er ikke av den største betydning, så lenge det eksisterer et 

løsningskart så er det et pluss for arrangementet. Det anbefales at arrangøren etterstreber å få laget 

et løsningskart på en eller annen form. Dette kapittelet tar for seg en av de enkleste måtene å lage et 

fullgodt digitalt løsningskart på og baserer seg på en mal vi har utarbeidet (Mal_losnings_xxxx.ocd) 

Metoden kan brytes ned til følgende steg: 

1. Preparere pre-o-kart til løsningskartet 

2. Tilpasse malfil 

3. Innlegging av siktepinne- og skjermplasseringer 

4. Skrive inn fasit 

5. Visuell behandling 

6. Utskrift/eksport 

HUSK: Det er veldig viktig at man lagrer ofte. Med jevne mellomrom bør man også lagre filen med 

nytt navn (f.eks. «dette_er_min_fil_versjon_xxxx.ocd») slik at man kan gå tilbake dersom man gjør 

feil. 

8.1 PREPARERE PRE-O-KART TIL LØSNINGSKARTET 
Før vi begynner på selve løsningskartet må vi 

omdanne pre-o-kartet slik at det kan brukes i 

løsningskartet. Det gjøres på følgende vis 

1. Gå til File > Open… på menylinja og åpne det 

ferdige pre-o-kartet. 

2. Gå til Map > Change scale… på menylinja 

3. Velg nå den målestokken du ønsker på 

løsningskartet (1:2000 eller 1:2500) og merk 

av for «Enlarge/reduce symbols» (viktig!). 

Vinduet skal da se ut som i Figur 27. Avslutt 

med «OK».  

4. Gå til File > Save as… på menylinja og lagre 

kartet med et nytt navn f.eks. «dette_er_mitt_kart_xxxx.ocd», der «xxxx» står for 

målestokken (2000 eller 2500). 

8.2 TILPASSE MALFIL 
For å starte med å lage løsningskartet må man først åpne et malkart som inneholder symbolene man 

skal bruke for å lage løsningskartet og legge inn pre-o-kartet som en bakgrunnsfil. Dette gjøres som 

følger: 

1. Gå først til File > New… på menylinja. 

Figur 27: Endre målestokk på pre-o-kartet som skal brukes til 
løsningskartet. Merk spesielt at haken foran «Enlarge/reduce 
symbols» nå skal være der. 
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2. Velg «Other file…» under «Load symbol set from:» 

3. Finn så fram til malfilen med navn "Mal_losning_xxxx.ocd" som tilhører denne 

dokumentasjonen og avslutt med «Open» og «OK». «xxxx» svarer til målestokken du lagret 

det omdannede pre-o-kartet i punktet ovenfor (altså den målestokken du ønsker på 

løsningskartet). 

4. Last nå inn det preparert pre-o-kartet i forstørret målestokk som en bakgrunnsfil ved å velge 

Background Map > Open… på menylinja og finn fram til der du har lagret det forstørrede pre-

o-kartet. Avslutt med «Open» og «OK». 

 

Det kan nå være lurt å lagre fila med et passende navn på vanlig vis. 

8.3 INNLEGGING AV SIKTEPINNE- OG SKJERMPLASSERINGER 
Det er nå klart for å lage selve løsningskartet ved å plotte inn plasseringene til siktepinnene og 

skjermene. Til dette bruker vi følgende fire symboler: 

 

Alternativ skjerm 

Riktig skjerm 

Z-plassering 

Siktepinne 

 

Disse fire symbolene kan velges fra symbollista i høyre meny. Når man har valgt det objektet man 

skal sette inn velger man et tegneverktøy (f.eks.  ) og trykker deretter der man ønsker å plassere 

symbolet. Om man vil kan man også merke hvilken bokstav hver av dottene svarer til ved å plassere 

bokstavsymbolene   ved sidene av dottene med et tegneverktøy, f.eks. 

. 

8.4 SKRIVE INN FASIT 
Når alle skjermene og siktepinnene er plottet inn på kartet er det klart for å skrive inn fasiten. Den 

enkleste måten å gjøre dette på er rett og slett og lage en liste på siden av kartet der man skriver opp 

fasiten. Det gjøres som følger: 

1. Velg symbolet «White Background» ( ) fra symbollista i menyen til høyre i hovedvinduet.  

2. Velg så tegneverktøyet «Rectangular mode» ( ) og lag et hvitt rektangel der du ønsker å 

plassere fasiten.  

3. Velg så et av tekstsymbolene ( ) og trykk øverst i den hvite ramma som akkurat 

ble dannet. Skriv så innfasiten (f.eks. 1A 2B 3Z …) Trykk «Enter» på tastaturet etter hvert 

individuelle fasitsvar dersom du ønsker at fasiten står skrevet nedover. 

8.5 VISUELL BEHANDLING 
Som for løypekartene skal vi avslutte med å legge på en ramme og skrive på informasjon om 

målestokk, hva de ulike symbolene betyr osv. Siden løsningskartet bør skrives ut i en målestokk som 

svarer til minst en fordobling av konkurransekartet (1:2500 eller 1:2000 er passende) er man som 
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regel nødt til å dele løsningskartet i to deler (med mindre løypa spenner over et så lite område at den 

får plass på et A4-ark selv i doblet målestokk). Vi anbefaler derfor at man på dette tidspunktet lager 

to kopier av dette løsningskartet, en for side 1 og en for side 2 av løsningskartet. Dette gjøres som 

følger 

1. Gå til File > Save as… på menylinja. 

2. Lagre fila med et navn som f.eks. «dette_er_min_fil_side_2.ocd» 

3. Gjenta så den samme prosedyren og navngi fila «dette_er_min_fil_side_1.ocd». 

Når dette er gjort er det klart for å legge inn ramme. Det gjøres på samme måte som vi gjorde for 

løypekartet. (Se beskrivelse under første del av kapittel 7.9.) 

Når ramma er plassert der den skal være kan du skrive inn annen kartinformasjon etter ønske (se 

andre del av beskrivelsen under løypelegging, kapittel 7.9), samt legge inn symbolforklaringsobjektet 

merket med .  

Når det hele er klart for side 1 av løsningskartet bør det lagres før man åpner filen for side 2 og 

gjentar den samme prosedyren denne siden – da selvfølgelig med en annen plassering av ramme slik 

at løsningskartene totalt viser skjermplasseringer for alle postene.  

Husk å også lagre side 2 når den er ferdiglaget. 

UTSKRIFT/EKSPORT 

Nå som løsningskartet er ferdig er det klart for å skrive ut eller eksportere disse kartene. Dette gjøres 

på nøyaktig samme måte som utskrift og eksport av konkurransekartet i kapittel 6 "Om utskrift og 

eksport av kart", bare at man må huske å velge målestokken man ønsker for løsningskartet i 

eksport/utskriftsmenyen som dukker på til høyre i vinduet når man velger «Export» eller «Print». 
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9 TIDSPOSTKART FOR PRE-O 

Alle PreO-konkurranser inneholder minst en tidspost stasjon, eller kun tidspoststasjoner, TempO. På 

en tidspost-/TempO-stasjon får utøverne utdelt et eget kartutsnitt per oppgave. Ettersom oppgaven 

skal løses raskest mulig er det viktig at tidspostkartet er utarbeidet i henhold til de retningslinjene 

som er satt for et slikt kart. 

Følgende retningslinjer er anbefalt å følge ved utarbeidelse av en tidspost/tempo stasjon: 

 Alle skjermene skal være tydelige fra utøverens sitteposisjon, og det skal ikke være noen tvil 

om skjermens ”bokstav” på grunn av at to skjermer ligger på linje fra løsningsposisjonen. 

 Det er anbefalt at alle skjermene er innenfor normalt synsfelt, slik at utøveren ikke trenger å 

snu på hodet for å registrere alle skjermene (120grader) 

 ”Opp” på alle kartutsnittene skal være orientert mot midten av sektoren som blir dannet av 

skjermenes utstrekning. 

 

Figur 28: Prinsippskisse for en tidspost stasjon 

Mange metoder kan benyttes for å lage tidspostkart, alt fra en fullstendig analog metode hvor man 

tegner postsirkel, postbeskrivelse, postsirkel med penn og klipper ut utsnittet, før man limer utsnitt 

korrekt orientert på for eksempel ei plastplate, til en fulldigital metode. Det er den siste metoden 

som er å anbefale da alle oppgavene blir likt utformet, og muligheten for tegnefeil reduseres. Selv 

om den digitale metoden benyttes må man ALLTID husk at teknisk delegert også må kontrollere 

tidspostkartene for eventuelle feil. 

Denne guiden vil forklare hvordan man på en relativt enkel måte kan lage fulldigitale tidspostkart / 

TempO-kart. OCAD er et greit verktøy å benytte til dette formålet, og beskrivelsen tar utgangspunkt i 

et allerede etablert pre-o-kart. Beskrivelsen henviser til funksjoner i OCAD 11, og tar utgangspunkt i 

tre ulike malfiler «TP_utsnitt_XXXX.ocd», «Mal_oppgavelayout_XXXX_PreO.ocd» og 
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«Mal_oppgavelayout_XXXX_TempO.ocd» der XXXX står for målestokken (5000, 4000, 2500, 2000). 

Stegene består av følgende hovedmomenter: 

1. Etablere ny OCAD-fil 

2. Rotere og eksportere kartet til ei kartfil per stasjon 

3. Justere kartets origo 

4. Lage kartutsnitt 

5. Lage tidspostkart 

6. Tidspoststasjoner/-oppgaver 

7. Alternativ metode 

HUSK: Det er veldig viktig at man lagrer ofte. Med jevne mellomrom bør man også lagre filen med 

nytt navn (f.eks. «dette_er_min_fil_versjon_xxxx.ocd») slik at man kan gå tilbake dersom man gjør 

feil. 

9.1 ETABLERE NY OCAD-FIL 
O-kart er produsert i mange forskjellige koordinatsystemer. Når vi skal lage tidspostkartene ønsker vi 

at alle kartgrunnlagene skal ha det samme koordinatsystemet. Vi starter derfor med å importere 

eksisterende pre-o-kart inn i ei tom OCAD fil. 

1. Velg: File > New… og velg Map type > Empty symbolset 

2. Angi ønsket målestokk for kartet: Map > Change Scale. Hovedregelen er at tidspostkartet skal 

ha samme målestokk som pre-o-kartet, men annen målestokk kan velges om arrangøren 

finner det hensiktsmessig. Avviker tidspostkart målestokken fra pre-o-kartet skal det spesifikt 

nevnes i PM. 

3. Importer pre-o-kartet: File > Import. Velg parameterne i Figur 29 under. 

 

Figur 29: Import pre-o kart for utarbeidelse av tidspostkart 



42 
 

4. Kartet kommer nå til syne, og vil være markert. For å fjerne markeringen, trykk et vilkårlig 

sted utenfor de markerte symbolene i hovedvinduet. 

5. Hvis objektene som er merket som skjulte (Hide ) i symbollista i høyremargen ikke skal 

være en del av tidspostkartet så skal disse slettes. Høyreklikk på symbolene som skal slettes 

og velg "Delete". Hvis dette ikke gjøres kan man risikere at objekter som egentlig ikke hører 

hjemme i tidspostkartet allikevel kommer med på kartet. 

6. Lagre en kopi av kartet for hver tidspost-/temp-o-stasjon ved å lagre kartet flere ganger med 

ulike navn via File > Save As… på menylinja. Bruk f.eks. navnene 

«mitt_uroterte_kart_stasjon_x.ocd» der «x» svarer til den aktuelle stasjonen. 

9.2 ROTERE OG EKSPORTERE KARTET TIL EI KARTFIL PER STASJON 
Det er viktig at kartet er rotert riktig i henhold til synsretningen fra stasjonen. Alle oppgavekartene på 

en og samme stasjon skal være rotert i samme vinkel i forhold til nordretningen. 

Rotering gjøres som følger: 

1. Åpne det aktuelle tidspost kartet som ble laget under foregående steg. 

2. Zoom inn på det aktuelle området hvor tidsposten skal være. 

3. Velg et linjesymbol, for eksempel veg, i symboloversikten, og benyttet tegneverktøyet for 

rett linje  , og tegn en rett linje fra der siktepunktet skal være (stolen) til senter av 

skjermsektoren, se Figur 28. 

4. Velg ”Measure” knappen  , og vinkelen fra siktepunktet til senter for skjermsektoren vil 

vises ved siden av "Azimuth". Kopier denne vinkelen ved å trykke på den den nederste av 

kopi-symbolene ( ). Noter ned rotasjonsvinkelen for senere bruk. 

5. Roter kartet slik at hjelpelinjen fra siktepunktet til senter for skjermsektoren blir orientert 

mot kartets topp (vertikalt i skjermbildet): Map > Transform > Rotate Map. Angi 

rotasjonsvinkelen, og huk av for ”Rotate objects with symbols orientated to north”. 

6. Slett til slutt hjelpelinjen ved å markere denne og trykke "Delete"-knappen på tastaturet. 

Kartet skal nå være orientert riktig i forhold til den aktuelle stasjonen. 

7. Lagre kartet som f.eks. «mitt_roterte_kart_stasjon_x.ocd» der «x» svarer til den aktuelle 

stasjonen. 

 

9.3 JUSTER KARTETS ORIGO 
 

For at man på en enkel måte skal kunne eksportere et tidspostutsnitt av kartet og benytte dette 

videre i etableringen av selve 

tidspostoppgaven må kartets origo 

sammenfalle med der hvor ringsentrum skal 

være for den aktuelle oppgaven.  

Dette gjøres som følger: 

1. Endre kartets koordinatsystem til 

”papir-koordinater”: Map > «Set 

Scale and Coordinate System», se 

Figur 30.  
Figur 30: Hak av for “papir coordinates”. Målestokken skal IKKE 
endres. 
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2. Velg at koordinatsystemet skal vises på i kartfilen ved å la knappen  på verktøylinja være 

markert (har da gul bakgrunn). 

3. Juster kartets origo ved å velge: Map > Transform > Affine…  

Klikk først på ”oppgavens” posisjon på kartet (altså der du skal plassere sentrum av sirkelen for 

den første oppgaven) (HUSK: Å zoome godt inn). Trykk deretter på kartfilens  origo. 

Koordinatene til musepekeren kan løpende ses under selve kartvinduet. Trykk til slutt på 

”Enter”-knappen på tastaturet. 

NB! Pass på at du ikke klikker i kartet flere enn disse to gangene før du trykker ”Enter”.  

4. Velg: Symbol > Select > Used, for å velge alle symbolene som er brukt i dette kartet. 

5. Pek på et av de valgte symbolene og velg: Symbol > Protect, for at alle kartsymbolene skal 

”låses” for videre redigering i kartet. 

6. Lagre kartet (med samme navn som i avsnitt 9.2 ovenfor). 

9.4 LAG KARTUTSNITT 
Tidspostkartet er nå ferdig orientert og sentrert, og vi skal nå lage kartutsnittet som skal benyttes i 

tidspostoppgaven: 

1. Pass på at du har kartet som du lagret i steget over åpent.  

2. Importer malfilen <TP_utsnitt_XXXX.ocd>, ved å benytte parameterne i Figur 31 under. 

a. Under Position: Place with offset.  

Her skal verdiene for offset være 0, både horisontalt og vertikalt. 

b. Under Symbols: Import all symbols and colors 

c. Under Colors: Import color at the top of the color table 

  

Figur 31: Parametere med import av "Mal_tidspostkart_preo_XXXX.ocd! 
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3. Du skal nå få opp en lilla sirkel på kartet, 

som i Figur 32. 

4. Velg den åpne  eller svarte  pilen 

fra verktøylinja, og klikk på den tynne 

rød streken som nettopp ble importert, 

se Figur 32. 

5. Eksporter kartet som er innenfor den 

tynne rød sirkelen ved bruk av: Map > 

Export Part of Map. Velg parameterne i 

Figur 33. Pass på at haken for ”Export 

with selected object” ikke er haket av. 

 

 

Lagre filen som eksporteres som for eksempel 

<Kart_stasjon1_oppgave1_elite.ocd>. 

 

 

 

9.5 LAG TIDSPOSTKART 
Kartutsnittet for tidspostoppgaven er nå laget, men vi ønsker å lage en komplett tidspost oppgave. 

Denne oppgaven skal kunne skrives ut, og brukes direkte på tidspost stasjonen.  

Dette gjøres på følgende måte: 

1. Åpne malfilen <Mal_oppgavelayout_XXXX_PreO.ocd> eventuelt 

"Mal_oppgavelayout_XXXX_TempO" avhengig av om det er en tidspost-/tempO oppgave. 

2. Lagre filen for eksempel som <Stasjon1_oppgave1_elite.ocd> 

3. Åpne kartutsnittet som du lagret under avsnittet over som bakgrunnsbilde: Background Map 

> Open. Kartutsnittet skal nå komme opp midt i tidspostoppgave malen, med postsirkelen 

sentrert på riktig posisjon i forhold til planlagt oppgave. 

4. Foreta nødvendige justeringer av innholdet på mal-fila i slik at disse stemmer for den aktuelle 

oppgaven. 

a. Juster nordpilenes retning i forhold til nordretningen på kartutsnittet. Dette gjøres 

ved å velge nordpil-symbolet med  eller , og deretter benytte funksjonen 

Object > Rotate Object > Rotate (Enter Angle)… Skriv inn rotasjonsvinkelen for 

roteringen i kapittel 9.2, punkt 4. Trykk tilslutt på OK.  

b. Juster evt.: overskrift, stasjonsnavn og ekvidistanse 

c. Legg inn korrekt postbeskrivelse, ved å velge symboler i symboloversikten, og 

plassere disse i riktig postbeskrivelse kolonne. 

Velg tynn rød sirkel 

Figur 32: Velg tynn rød sirkel for å lage tidspost kart  utsnitt 

Figur 33: Eksporter ved å velge "Use selected 
object" 
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5. Lagre tidspostoppgaven og skriv ut oppgaven i riktig målestokk som beskrevet i kapittel 6 

"Om utskrift og eksport av kart”. 

9.6 TIDSPOSTSTASJONER/-OPPGAVER 
Du har nå laget en tidspostoppgave, men man har som oftest behov for å lage minst to oppgaver, og 

ved en temp-o-konkurranse er det også behov for å lage flere oppgaver med utgangspunkt i flere 

stasjoner.  

Følgende gjøres for å lage flere tidspostoppgaver fra samme stasjon: 

1. Gjenta punktene 9.3 - 9.5 for alle tidspostoppgavene. 

Følgende gjøres for å lage flere tidspoststasjoner, og oppgaver: 

1. Gjenta punktene 9.2 - 9.5 for alle tidspoststasjonene, og punktene 9.3 - 9.5 for alle 

oppgavene per stasjon. 

9.7 ALTERNATIV METODE 
Her beskrives en alternativ metode for hvordan man på en enkel måte kan lage tidspostkart. Det er 

anbefalt å benytte metoden som er beskrevet under kapitlene 9.1 - 9.6, men om den metoden synes 

uoverkommelig kan følgende metode være et alternativ med en lavere terskel. Opplegget for denne 

metoden er som følger: 

1. Åpne malfilen <TP_utsnitt_XXXX_alt2.ocd>: File > Open 

2. Lagre filen for eksempel som <Stasjon1_oppgave1_elite.ocd> 

3. Åpne pre-o-kart som bakgrunnsbilde: Background Map > Open.  

4. I vinduet som dukker opp velges «New offset» under 

«Map offset» før man avslutter med «OK». 

5. Velg deretter knappen for «Entire map» i Figur 34 for å få 

tegnet opp hele kartet.  

6. Velg punktsymbolet , etterfulgt av et tegneverktøy 

(f.eks.:   ).  

7. Zoom godt inn i kartet og trykk eksakt der sentrum av 

tidspostoppgaven skal være. 

8. Postsirkelen og et hvitt dekke rundt denne vil gjøre at du 

får akkurat det tidspostkartet som du trenger. 

9. Skriv ut tidspostkartet i riktig målestokk som beskrevet i 

dokumentet ”Utskrift og eksport av kart”.  

10. Klipp ut det utskrevne tidspostkartet, og lim dette korrekt orientert på et egnet medium 

(f.eks. en papp plate) som inneholder de nødvendige opplysningene slik som bl.a. 

postbeskrivelse og nordretning. Et slikt underlag kan med fordel lages ved å benytte malen i 

kapittel 9.5, men droppe å laste inn noe et bakgrunnskart. 

For å lage flere tidspostoppgaver med denne metoden kan du enten flytte sirkelen du la inn under 

punkt 5. ved å bruke den åpne  eller svarte  pilen fra verktøylinja og dra punktet til ny riktig 

posisjon, eller å slette sirkelen og sette inn en ny i den nye posisjonen. 

Figur 34: Velg knappen "Entire map" for å 
tegne opp hele kartet. 
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Denne guiden beskriver to forskjellige måter å lage tidspostkart på, og det er den fulldigitale 

metoden som er beskrevet med kapitlene 9.1 - 9.6 som anbefales brukt.   
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10 OPPSUMMERING 

 

Å forberede kart og løyper til en pre-o-konkurranse er en tidkrevende jobb.  Gjennom denne guiden 

har du forhåpentligvis lært deg å bruke de viktigste verktøyene for karttegning i OCAD og hvordan 

man legger løyper for pre-o i OCAD. I tillegg har naturlig nok fokus i all hovedsak vært på hvordan 

pre-o-spesifikke «oppgaver» kan utføres i programmet. Omdanning av ordinært fot-o-kart til pre-o-

kart, hvordan lage løsningskart og tidspost-/temp-o-kart samt hvordan andre finurligheter i pre-o-

verdenen kan utføres i programmet, er blitt dokumentert. Det er ikke kjent for skribentene at det 

eksisterer dokumentasjon av disse pre-o-spesifikke oppgavene fra før. 

Selv om OCAD er det helt klart mest brukte programmet for karttegning og løypelegging, finnes det 

alternativer: 

Open Orienteering Mapper er et kartteningsprogram basert på åpen kildekode. Programmet er 

foreløpig i en tidlig utviklerfase og mangler en del nyttige funksjoner. Programmet utvikles imidlertid 

stadig og kan muligens bli et reelt alternativ noen år fram i tid. Per nå er det imidlertid ikke mulig å 

legge løyper, lage tidspostkart, løsningskart eller lignende i dette programmet. Versjon 0.4 av 

programmet kan lastes ned (gratis) fra programmets hjemme: http://oorienteering.sourceforge.net 

Som nevnt er det ikke mulig å legge løyper i Open Orienteering Mapper. Det er imidlertid mulig i 

programmet Purple Pen, som også er gratis. Nyeste versjon 1.2.1 støtter ikke løypelegging for pre-o, 

men det er ventet at dette vil bli inkludert ved senere oppdateringer. Siden programmet kun er et 

løypeleggingsprogram er det imidlertid ikke mulig å lage verken tidspostkart eller løsningskart i 

programmet. Programmet kan lastes ned fra programmets hjemmeside: http://purplepen.golde.org   

 

Om du finner feil, mangler eller det er noe som er beskrevet dårlig i denne guiden, vennligst send en 

e-mail til preoliten@gmail.com. Det samme gjelder dersom du har problemer eller ønsker om f.eks. 

andre målestokker for våre OCAD-maler som finnes her: 

http://dl.dropbox.com/u/14588107/Diverse/OCAD_kurs/Pre-o-maler_OCAD11.zip.  

 

http://oorienteering.sourceforge.net/
http://purplepen.golde.org/
mailto:preoliten@gmail.com
http://dl.dropbox.com/u/14588107/Diverse/OCAD_kurs/Pre-o-maler_OCAD11.zip

